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Thank you for purchasing Spark Creative Drum Machine!

This manual concerns two distinctive products:

Spark software, a highly creative beat production center
Spark MIDI controller.

In this package you will find:

A DVD-ROM containing Spark Creative drum machine installer for Mac OS X
and Windows XP/Vista/Seven

A registration card (credit card format) including the Serial Number and
Unlock Code.

The User’s Manual for Spark Creative Drum Machine software and the Spark
MIDI Controller.

Spark MIDI controller
An USB cable

Carefully store your registration card!

In order to actually use the software, you have to register, then authorize your virtual
instrument. By registering, you identify yourself as the legitimate owner and thus will be
sure to receive the latest news and updates for your instrument.

The Serial Number and Unlock Code are required to register & authorize Spark, so these
codes are the real value of your product.

See chapter 3 Registration & Authorization for more information about the authorization

process.
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Special Message Section

The MIDI controller uses USB or an external power adapter. Do not connect this product
with any other power supply or adapter than the one described in this manual
specifically recommended by Arturia. (See chapter 7.1.9 for more details).

WARNING:

Do not place this product in a place or position where one might walk on, trip over or roll
anything over power or connecting cords.

The use of an extension cord is not recommended! If you must use one, make sure the
cord has the ability to handle maximum current needed by this product. Please consult a
local electrician for more information on your power requirements.

This product should be used only with the components supplied or recommended by
Arturia. When used with any other components, please observe all safety markings and
instructions that accompany the accessory products.

SPECIFICATIONS SUBJECT TO CHANGE:

The information contained in this manual is believed to be correct at the time of printing.
However, Arturia reserves the right to change or modify any of the specifications without
notice or obligation to update existing units.

IMPORTANT:

Always follow the basic precautions listed below to avoid the possibility of serious injury
or even death from electrical shock, damages, fire or other risks.

The product used either alone or in combination with an amplifier, headphones or
speakers, may be able to produce sound levels that could cause permanent hearing loss.
DO NOT operate for long periods of time at a high level or at a level that is
uncomfortable.

If you encounter any hearing loss or ringing in the ears, you should consult an
audiologist.

NOTICE:

Service charges incurred due to a lack of knowledge relating to how a function or feature
works (when the unit is operating as designed) are not covered by the manufacturer’s
warranty, and are therefore the owner's responsibility. Please study this manual carefully
and consult your dealer before requesting service.
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PRECAUTIONS INCLUDE, BUT ARE NOT LIMITED TO, THE FOLLOWING:

Read and understand all the instructions.
Always follow the instructions on the instrument.

Before cleaning the instrument, always remove the electrical plug from the
outlet, as well as the USB cable. When cleaning, use a soft and dry cloth. Do
not use gasoline, alcohol, acetone, turpentine or any other organic solutions;
do not use a liquid cleaner, spray or cloth that's too wet.

Do not use the instrument near water or moisture, such as a bathtub, sink,
swimming pool or similar place.

Do not place the instrument in an unstable position where it might
accidentally fall over.

Do not place heavy objects on the instrument. Do not block openings or
vents of the instrument; these locations are used for air circulation to prevent
the instrument from overheating. Do not place the instrument near a heat
vent or any place of poor air circulation.

Only use the recommended specified AC adaptor (9 Vdc, 800 mA)

Make sure the line voltage in your location matches the input voltage
specified on the AC power adaptor.

Do not open and insert anything into the instrument that may cause a fire or
electrical shock.

Do not spill any kind of liquid onto the instrument.

Always take the instrument to a qualified service center. You will invalidate
your warranty if you open and remove the cover, and improper assembly
may cause electrical shock or other malfunctions.

Do not use the instrument with thunder and lightning present; otherwise it
may cause long distance electrical shock.

Do not expose the instrument to hot sunlight.
Do not use the instrument when there is a gas leak nearby.

Arturia is not responsible for any damage or data loss caused by improper
operations to the instrument.

HANDLING CD-ROMS:

Avoid touching or scratching the shiny underside (encoded surface) of the disc. A
damaged or dirty CD-ROM disc may not read properly. Keep your CD-ROMs clean, using
a commercially available CD cleaner.

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’S MANUAL 6



Table of Contents

1 INTRODUCTION 11
I.1  WELCOME TO SPARK ......oiitiiuiiiiiiiitieie ittt sttt sttt st s s e ae s sa e s a e see e b e saaesre e s eae s 11
L2 120 HISTORY oot e e et s e s e s b s h e e a e s eene s 11

2 INSTALLATION 13
2.1 WINDOWS INSTALLATION (7/XP/VISTA) ..coiiiiiieiieeitecee ettt ettt sttt st see e etaeeaaesteesesaenseeseseen 13
2.2 MAC OSX INSTALLATION (10.5/10.6) ..eeevieiiiiiiesiieeiiesieeieesteeeveeieesteeseeeseteestaessseessaeenseenseessseenseesssenn 17

3 REGISTRATION & AUTHORIZATION 18
3.1 REGISTRATION ...ttt st h et a e e st e e s e e e e s e b e e e b e e b e eaeeene s 18
3.2 AUTHORIZATION ....oiiiiiiiiiiiiiiite ettt st a et a e s h e e e s a e e e se e e e sae e b e see e b e e e e b e eaeeeae s 20

4 QUICK START 21
4.1 SPARK CONTROLLER OVERVIEW ......cuiitiiiiiuiiiiiiiiiii it et sttt ae s s 21
4.2 SPARK SOFTWARE OVERVIEW ......ciuiiiiiiiiiiiiiiiii ittt st st e s e s s s 21

421 The COnter PANEL............cccoeeeueeiuieiiieeiieeie et ettt ete et ettt e st et e saae e bt e s sbeeateessbeanseensseesaenaseesseas 22
4.2.2  The BOtIOMI PANEL ...........cuoeeeeeiieeiieeee ettt ettt ettt ettt e et e s b e esteestbeanseessbeesaenaseenseas 22
42,3 THE TOP PANCL........cooeeeeeiieeeeie ettt ettt ettt e et e st e et e et e e beeesbeeabeessbeanbeessbeesaenaseenseas 23
4.3 NAMES AND CONCEPTS YOU SHOULD KNOW .......coiiiiiiiiiiiiiiiiiiesie et s s s 24
I B B o o) I AU 24
1 1 S S SPSRTRR 24
.3.3  IISTFUIENL ...ttt et ettt e ettt e ettt e e at e e et et e ettt e ettt e taeeenneeennees 24
.34 AUAIO SOUFCE ..ottt ettt ettt e et e e bt e e sbe e bt e s sbeebeesaseesaenaseenseas 25
3.5 BARK ..o et ettt 25
O I o177 L SRS 25
S AN Yo 1 -SSP 25
3.8 CRANNEL ...ttt ettt ettt et et e et e ettt e et et e e taeenreeteas 25
3.9 THACK oottt bttt e be e abe bt rbeeteeetbeebaenareentean 25
4.4 AUDIO AND MIDI SETUP. ...ttt e e s 25
B4 ] TIRAOWS ..ottt ettt ettt e et e st e e b e e e st e e bt e e sb e e bt eesbeebeeeabeetaennreenteas 25
4.2 MAC OS X .ottt ettt 25
4.5  FIRST STEPS WITH SPARK ..o e 26
4.5.1  LOAAING A PTOJECE ..ottt ettt st ettt e s e et e s abeabeestbeesaensseenseas 26
4.5.2  SeleCt ANA PIAY A PATEEIT.............ccveeeeiiiiieeieee ettt ettt sabeebaeeaseenneas 26
4.5.3  Change INStrUMeENt DAFAMEIEES..........c...ccveeeeeeeeesiieeieeeseesseesteesseesteeseseesteesseeseessbeasseessseessaessseenseas 27
4.5.4 Select an Instrument and change filter and mixer paramerers ..............cccoeveeeeveeviesveeecreeneeecreennns 27
4.5.5  Play and edit @ DAL ............cccooccueecuiieiiieeiieeie ettt ettt ettt sae et e e et e etbeebaeeaaeeneas 28
4.5.6  Record a pattern With iNStrUMENTE DAAS ...........c...ccueeeueeeieeiieseeeieeeiieeteeetee et saeesseesiaeensaeeaseeeeas 28
4.5.7 Change Instruments/Kits With the Jog diQl...............cccccueovieiiiiiiiaiieeiiecie e 29
4.5.8  SAVE YOUF PFOJECT......cceeeeeeee ettt ettt e et e et e e st e e et e e et e e enseeennnes 30
4.5.9  SWIECHITG VIEWS ...oovveeiii ettt ettt et ettt e e ettt e e sbe e st e e sbaestbeebaeesbeenbeessbeenseessbeesaennseenseas 30

5 USING SPARK 31
5.1 THE TOOLBAR ...ttt a e s st a e s e a e s e b eee e b e e sa e eeae s
5.2 THE MAIN PANEL (OVERVIEW)

5.2.1  The Digit@l diSPIAY .........ccoooeveeiiiiiieiiee ettt ettt ettt et ettt neas
5.2.2 THE SCQUENCEE ZOME...........ooceeeiieeieeiee ettt e et et et e st e et e et e e bt e esbeaabeessbeenseestbeesaensseenseas

IR0 B N (T IN 157 o3 o T (TSP SRUST

5.2.2.2  The Shuffle Knob....................

5.2.2.3  The Transport Zone.................

5.2.2.4  The Tap Button .........c...........

5.2.2.5 The Tempo Button...................

5.2.2.6  The Accent Button...................

5.2.2.7 The Erase Button...................

5.2.2.8  TRE LOOP ZOME ..ottt ettt sttt ettt b e b e bt e bt bt e bt et et et st s e e nae et
5.2.3  The SONG/PALIEITL ZONE .......ccuveeeeeeieeeieeie e ettt ete ettt et e st et e sabeebaessbeeateessbeaseestseesaenaseenseas

5231 ThE SONEZ MOGC....c.iiiiiiiiiiiiiiiesieeteet ettt ettt sttt b ettt et b e s bt sb e bt e bt et et et enbesbenbenee

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’S MANUAL 7



5.2.3.2 Editing Songs from the Main Panel ...........cccoeriririniiiiiiieienesereee ettt 39
5.2.3.3  Banks and PatteIms ......cueueriiriiriiiiieiieieteteest ettt b ettt see e et 39
5204 TRE JOZ DIAL.........cceoeeeeeee ettt ettt ettt e ettt e bt e et e eareenteas 40
52,5 The FX LIV PAG........cc..ocuoieiieeeeee ettt 41

5.2.6.1
5.2.6.2

5.2.6.3  The ROIET DULLOMN ...ccuviiiiiiieiie ettt ettt e ettt e et e eete e e et e e eteeeetseesasesenbeeesseesnseeenseeeassaeans 42
5.2.7  The INStrument CONIFOL ZONE. ................cccccuiiiiieeiiie ettt 43
5.2.7.1  The InStrumMENt PAGS.........oooiuiiiiiiiiiieciee ettt ettt e et e e et e e etaeeeabeeebeeeetaeeeateeeraeenseaeans 43

5.2.7.2  The Parameter KNODS. .......coiiiiiiiiiiiiieieeeesee ettt sb ettt et sae e i ene 43
5.2.7.3  SELECt BULIOM ...c..euiiiiiieiieiieieee sttt sttt ettt b e e bbbt et ettt st nae et 44
5274 1-8 79160 BUMOM ...eiuiiiiieiieteeeete ettt ettt et b e s b et st b e st b e e bt b e st e b e s es e e b en e et et e st et et et e eeneeeenes 44
5.2.7.5  MULE DUIOI .c..eutitiiiieeiteitetet ettt b e eb et ea et st st s bt s bt e b bt e st et e b e b e e b e sb e e bt e bt e st esbenbenbestenaenne 44
5.2.7.60  SOLO DULOM ettt ettt et st b e bt e b e bt e st et e e b e s b e sb e e bt e bt eat et e b enaesaenae et 44
5.2.7.7  FIlter/MIXET PATAIMELETS ...ecuveruveeureriiereiesieeteeseeseeseestesssessaesseesseesseeseesseensessseassesssesssesseesseesseessesnseessesssessees 44
5.3  THE BOTTOM PANEL (OVERVIEW) ....ccctteittieitiesiteesteestreeseesssesseessseasseessseesseessessssessssssssessssessseesssssssessseesns 45
5.3.1  The StUAIO..........ccoooveeeiiieeieeieiieea
5.3.1.1 Instrument Edit Window
5.3.1.2  Studio Buttons.........ccccceuererene
5.3.2 THE MIXET ..ottt ettt ettt e et e et e et e ettt abe et rbeabeeetbe e taenareenteas
5.3.2.1  The INStUMENE tTACKS ....c.veiiriiriiiiriieiieitetet ettt sttt ettt et s be bbbttt eaestesbenbe et
5.3.2.2 The Return 1 and 2 tracks....
5.3.2.3  The MaSET tTACK ..c..eeuiiiiiiieieierteseet ettt sttt b ettt s b e bt bt et et e ntesbenae et
53214 TRE EITEOES ..cuvititeeieeiee ettt sttt ettt b e bbbt ettt ettt nee et
FX parameters ................
Compressor parameters......
Bit Crusher parameters...
Chorus parameters..........
Delay parameters.........
Distortion parameters .........
Parametric EQ parameters..
Phaser parameters...........
Plate Reverb parameters.
REVETID PATAIMELETS ...c..vieieiiieetiecieeeee ettt et et e et e st e st este et e esseesseanseesseanseesseessesseessaeseesseanseenseenseensennsenseas
5.3.3 THE LIDFAFY ..ottt ettt et e et ettt e s e ettt e et et e e taeeareenreas
5.3.3.1 The Library Window................
5.3.3.2  The Current Project WINAOW .........cccceiriiiiiirienintenteeieeeeteteste sttt ettt see bbbttt aesaesbesae e 60
5.3.3.3  CreatiNg @ NEW PIOJECE ...c.veuirtirtirtirteettettettettetentestesteeteettett et et e stestesbesbeebeebeemtentens e besbesbeebeebeensentensentenbesienne 60
5.3.3.4 How to load Kits and INSIIUMENTS ......cceeuiiiriinininiinieiet ettt ettt ettt sb et sae e e sae e 61
5.3.3.5 How to load Banks and PAtteIns .........cccueuiriiriinininirieieteteese ettt nae e 61
5.3.3.6 Importing and EXPOIting @ PIOJEC......cceetiruiriirirtiniiniieiieitetete sttt ettt ettt s bbbttt e b seeseesae e
5.3.3.7  SAVING @ PIOJECE.c..eviriieiieitetetertest ettt ettt ettt s bbbt et et b et e sae st e s bt s bt e bt ebtes e et et e besbeebe e bt ebeentensenbenbententeene
54 THE TOP PANEL....oiittiitiiitieite ettt ettt ettt et ettt ettt e b et st e bt st e bt e s et e enbeesateenbeesaneebeenas
S:4. L OVEFVICW ...ttt et ettt ettt ettt et ettt et e e e taeeenbeeennnes
5.4.2  THe PALIETI PANEL .........cc.oeeeeieee ettt ettt ettt et eateeetbeebaeenseenseas
5.:4.3 THE TOOIDAT ...ttt ettt ettt et e et e s e e bt e s tbeensaesebeasaeeaseenseas
5.4.4  THE SCQUENCET .........oeeee ettt ettt et e et et e e ba e et e e baeesbeaabeesabeanseesabeesaenaseenseas
54.4.1 How to select a track................
5.4.4.2 How to copy or swap tracks
5443  HOW tO COPY OF SWAP SEEP PATLS c.veuveveruieuieutitentententertesieettestestestestestesbeebeeseestentensessesbesbeeseeseensensensensessensense
5.4.5  The AULOMATLION @ATLOF .........c..cccuveeeeeeieeiiieieeeee et eee ettt et et e et e e e e beessbeebeessbeaseessbeesaenaseenseas
540 THe SONG PANEL ........cccuoooeeeeeeiie ettt ettt et e et e s sbe e bt e stbeeseessbeesaenaseenseas
5.4.7  The Song SIOLS .......cccvevevveciaeieaiieeieenaens
5.4.7.1 How to copy patterns to song slots. ......
5.4.7.2 How to move and paste/insert slots ......
5.4.7.3  How to set SONE PlaYINg POSTEION .....ecueeuteuiiiitintirtintirteeie ettt sttt ettt et et be s b sbe e bt e bt e s esnenestesteseenee
5.4.74 How to select several slots
5.4.8 Preferences Button....................
S54.8.1  SCQUENCET PIEIEIEIICES ...vieviiieiieiieiiiestiesteteee et ete e et e st e st e st este e seesseenseesseesseessesseesseesseenseenseenseenseenseeneas
RO R A O 1 (e 0 (S (<) () 4 Lot PR SRUTR

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 8



5.4.8.3  MIDI IMport/EXPOrt PrefereNCES: .. .ccuieriietieiieiieieeieeiesteeeie sttt steete et eesaesaeesaesseesseenseenseenseenseenseeneas 68
R R T S 070} 113 00 | (S o 0 S5 (53 () 1 1 TP SRUT 68

6 MODES OF OPERATIONS 69

6.1  STANDALONE (OVERVIEW) ..cuutiiitieiieeiteeiereesteessseesseesseessseesssessseesssesssesssssassesssessssessssssssessssesssessssesssesssessns 69
6.1.1  Launching the standalone appliCAtiON ...............c...cceeceiiiieioiieiieiiie ettt sae et sveesiae v ens 69
6.1.2  Preferences configuration — Audio & MIDI SEIHINGS ...........ccocccveivureeeeeiriesieecieeeiieeieesiee e esaeeiee e 69

0.1. 2.1 WIIAOWS ..outintiiiiieiieiteitet ettt b e e bbbt e bbb e st et e s ettt s bt e bt e bt e bt e st et et e b e e bt eb e e bt ebee st et entenaesbenbenne
6.1.2.2  IMAC OS X ittt ettt h bttt e h bbbt ettt b e bbbt bt et et e bt ntenteene
6.1.3  Update Spark CONIFOLIET..............c..ccoveiiiiiiieiieeii e ettt ettt st sbeesteesbeeseesaseens
0.1.3.1  WIIAOWS ..ottt ettt et s h e bbbt et et s et et s bt e bt e bt e bt e st et et e b e e beeb e e bt ebbe st ententenaesbenbenne
6.1.3.2  MAC OS X ittt h bt a e bbbt b e sttt b e bbbt et e st et ettt ente et

6.2 PLUG-IN MODE......c.uiiiiiiiiiiiiii et s st s s s a e
0.2.1  TOOIDAY EXIFA BUITOMNS........c.oeecveeiiieeieeciie et ee et e et et e ettt e et e sabe e taeesbeetaessseenseessseeseensseans
0.2.2  SAVING PFOJECE.........eeeieeeee ettt ettt e e e e ettt e et e e et e e et e e bt e e b e e et e e nbeeennnes

0.3 VST et h b et h e n e bttt h et e h e et et e bt ee e e bt st e bt e s et e en e ebeenes
0.3. 1 IBSEQIIATION ...ttt ettt e st e b e e ab e e baeeebeesteessbeesseesebeensaenaseens

0.3 1.1 WIIAOWS .outintiiiiieieeiteie ettt b e bt bbbt bttt s e st s bt e bt e bt e bt e st et e e e b e e bt eb e e bt e bt e st essenbenaesbenbenne
63.1.2 MacOSX
6.3.2  Instrument use in VST mode

6.3.3  Connection to an iNSTUMENE [FACK ............c...ccceeeieiieecieeeiie ettt ettt ste et e saeeaeesbeesaesaneens 73
0.3.4  Multi QUIDUE MOGE..............c.ooeceeeeieaiieiiie ettt ettt et e et e st taeeabeeteeesaeeseestbeesaensseens 74
6.4 AUDIO UNIT (IMAC OS X ONLY) .tteeuteetieiureesueenueesieesseeaseesseesseesssessseessssassesssesssessssessseesssesssessssssssasssessns 74
0.4. 1 IISEQIIATION ...ttt ettt e et e et et esab e e baeesbeesseessbeenseessbeensaensseens 74
0.4.2  USE 51 LOZIC PFO ..ottt ettt et e ettt e et e et e e et e e e e e nnnes 75
If an Arturia plug-in poses problem in Logic, start by checking that this plug-in has passed the compatibility test,
and that it 1S CtUALLY SELECTEM. .....ecueruiriiiiieiieiit ettt b et b ettt et nbe b st nae et
6.42.1 Stereo Mode.......ccoceverueeeennee
6.4.2.2  Multi Output Mode
6.4.3  US€ iN DIQItAL PEFOFIMEE ......cc.ovouveeveeiie ettt ettt ettt et e tae et esabeeteessbeetaestbeesaennseens 76
0.4.3.1  STETEO MOTEC ...ttt ettt ettt st b e bbbt et et et bbbt e bt e bt et et et et nte st et
6.4.3.2  Multi Ouput Mode
6.4.3.3  Assign Midi Track
6.4.4  Stereo Mode and Multi OUIPUE MOGE..............c...cooocueeiiiiiieiieiie ettt 77
0.4.4.1  STETEO IMOGEC ...ttt ettt et st s b e bbbt et et et b e b e bt e bt e bt et et et et stenae et 77
6.4.4.2  MUltl OULPUL MOAE ...ttt sttt b ettt b e bt s bt e bt bt et et ebenaesbenbe et 77
0.5 PRO TOOLS ...ttt ettt et b e b e b e ettt es e e bt em et e b e et e bt e et ee e e bt esee bt en e e bt en s e et e enteeseenes 78
0.5. 1 IBSEQIIATION ...ttt ettt ettt s bt et e s et e e taeesbeesseessbeenseessbeensaentseens 78
6.5.2  Utilization and opening Of the PIUZ-IT...............ccccceeviiiieiiieiie ettt ete e sae e saeesaae v ens 78
0.5.3  SAVING tHE PFOJECE....c.uveevi ettt et e et e et e et e s tb e e bt e s tb e e taeesbeesseeesbeenseeseseanseenaseans 78
6.5.4  Automations URAEr Pro TOOLS ..............ccc.ccouevvuiiiieiieeie ettt ettt ettt ae et sveeaaesaseens 79
7 THE SPARK MIDI CONTROLLER 80
7.1  FRONT PANEL (OVERVIEW) ..uutiitieitieeteesireeseessseeseesseessseessseasseesssesssesssssassesssessssessssssssessssesssessssesssesssessns 80
Todi 1 DI@VICE POTES ..ottt ettt ekt e et e ettt e e e nb e e et e e nb e e ettt e e entaeeenteeetaeeenn 80
7.1.2  Choose between Kit OF INSTFUMENTE MOAE .............c..ccoueeceeeiiieeiieiiesieeeesie e eae s 81
7.1.3  Set MOVE KNOD MOGE .............ooccoveiieiiieiiiciieeieees ettt ettt et sabeetaeenaeeneeas 81
7.1.4  Set Sequencer FOIow Mode On / Off.........ccoooueiiiiiieiieiiieeieeee et 81
Todo5 ROIIEE FXuooouooiiieiieiieeee ettt ettt ettt e ettt e e ab e et e e nb e et e enbeenneeeabeetaeenbeenteas 81
7.1.6  CORPOIIET SHOFICULS......oocev ettt ettt ettt et e et e e sbeeteeesbeessaessseesaesnseenseas 82
7.1.7  Us€ @S SPATk CONIFOLIEE .........ccooeiieeieiiieieeeeeee ettt ettt e sabeetaeenaeeeeas 83
7.1.8  Us€ @S MIDI CORIFOILET ..........cccooeeieiiieiieiieeieeee ettt ettt staesiseetaeenseeneeas 83
7.1.9  Us€ @S USB/MIDI THIEITACE .........cc.oeeveeiiieiiieieeeis ettt ettt e ettt staeseseestaeenseeneeas 83
TA 1O POWEE SUDDIY ...ttt ettt et ettt et e et e et et e et e s e e ntaeeebeetaeenbeentean 84
7.2 REAR PANEL (OVERVIEW) ..eicutiiitieiieeiteeireenseessaeesseesseessseesssesseesssessseessssassesssessssessssssssessssesssessssesssesssessns 84
7.2.1  Rear panel Connectors and POWEr SUPPIY ...........cc.covueecueeiuieeiieeiieesee et esiie e esiee e staeseseestaeeseeeeas 84
7.3 SPARK MIDI CONTROLLER SOFTWARE .......oiuiiiiiiiiiiiiiiiiiiiieiti ettt s s s s 84
7.3. 1 OVEFVIEW ..ottt e et e e ettt e ettt e e tb e e Rt e e ettt e nt e e e tb e e ettt e enteeetaeeen 85
7.3.2  THE MENU......c..oooeeee ettt ettt ettt e ettt e e e et e nb e e bt e nbeeenaeeabeetaeenneentean 85
T.3.2.1 Ml TEMPLALES ..ouveeereiieiietieie et ete ettt et et et e ebeestessaeeseesssessee st aenseensaenseanseessaansesssesssesssenseenseenseannn 86
7.3.2.2  Pads CaliDIatION ....cueeuieuieiieiieiieietetee ettt ettt b et b ettt aesae st e e eae 86
7.3.3  Edit InStrument PAd WIHAOW ..............cc.cccueviuiiiieeiiieeieeeie et ste et e sve e esiae e essaesveessaessseessaesnseenneas 87
7.3.4  Edit InStrument koD WIRAOW.............c..ccccooviiiiiiii ittt ettt be s 88

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 9



7.3.5  Edit Instrument parameter knob WinAdOW .................cccoecviiieiiieiieiiiieeeeeie et 88

7.3.6  Edit Clickable knob WildOW..............c..ccoocuiiiiiiiiiiieie ettt
7.3.6.1  The Jog Dial (Wheel).......cccceeenenennnne.
7.3.6.2  The Move button (Loop Move)

7.3.7  Edit TOUCH PAA WIRAOW........c.ooceiiiiiiiiieieeie ettt ettt et sbeestaesibeetaeenseeneeas
7.4 CONTROLLING SPARK AN EXTERNAL MIDI CONTROLLER........ccciciiiiiiiiiiiiiiiiicnie e 90
7.4.1  ASSIgN @ MIDI FOTE 0 PAAS..........ccooooeeeiiiiiieiieeis ettt ettt e sebaetaeenaeeneees 90
7.4.2  Assign a MIDI ROte 10 DANK DUITONS.............c..cooveviiiiiiieeieeciiecie ettt sve et se s 90
7.4.3  Assign a MIDI ROte (0 PATLETI DUIONS ............c.coecuieeiieeie et et sttt et st sereetae e 91
7.4.4  Assign a MIDI Rote t0 I0OP O DUITOMN ............ccoeviuiieieeie e ettt ettt sve et eae s 91
7.4.5  Assign a MIDI CC to LOOP divide KNOD ...............c.c.ccouevcueiiiieiiieiieiiieeeeie et 91
7.4.6  Assign a MIDI CC t0 LOOP MOVE KROD..............cccoooiuiiiiiiiiiiiieiieciieeeee et 91
7.4.7  Assign @ MIDI CC t0 SRUSFIE KTOD .............ccoooveeiiiiiieeie ettt 91
7.4.8  Assign a MIDI CC to master VOlUume KnOD ...............ccccccoovveevieiiiiiiiaiiesie et 91
7.4.9  Assign a MIDI CC to cutoff/res/Pan/Aux1/Aux2/Volume knobs..............c..cccoecvivvenceacianireannannn 91
7.4.10  Assign a MIDI CC to instrument parameters KnobS ............c...cccccveeviviiiiieniieiiiesie e 91
7.4.11  Assign a MIDI CC 10 teMPO KNOD ............c.ooveeiiiiciieeie ettt stae et ese s 91
8 SPARK CREATIVE DRUM MACHINE LEGAL INFORMATION 92
8.1  SOFTWARE LICENSE AGREEMENT .......oiiuiiiiiiiiiiiiiiieii ettt s s s s 92
8.2  FCCINFORMATION (USA) .ttt ettt ettt sttt st h et eb et e b et ese et eaeenee e e e naeeneas 94
8.3 CANADA ettt ettt ettt et bt et h et h et eh et h et e h et eae ettt e nbeeneas 95
8.4 EUROPE ... .ttt ettt et s h et b et e bbbt et e b et e h et eae et et e nbeeneas 95
9 NOTES: 96

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 10



1 INTRODUCTION

1.1 WELCOME TO SPARK

BEAT THE FUTURE

Combining the power of analog synthesis, physical modeling and samples, through the
intuitive workflow of a hardware drum machine, Spark is a highly creative beat
production center. Spark will save you time when looking for the right drum kit and will
get you hooked by its amazing ease-of-use and sound possibilities.

Spark embeds vintage analog drum machines, sample based beatboxes and acoustic
drum sets. Then Spark lets you break through their sonic boundaries thanks to a highly
tweakable controller.

With in-depth control over your sounds, an advanced loop mode and an XY touchpad
with 8 real time effects, Spark will allow you to create unique beat experiments and
constantly feed your creativity with innovative ideas.

Spark’s sonic power is nothing but huge, embedding three distinctive drum engines:
analog synthesis, sampling and physical modelling. Thanks to its automations available
on all parameters, every kit is very tunable and customizable, bringing a fun and
complementary approach to sample browsing while making it more interactive and user-
friendly than similar products.

Incorporating a 16-step sequencer and 8 velocity sensitive touch pads into a sturdy beat
station, Spark is your weapon of choice to bring the best groove into your tracks
whether you are working in the studio or performing on stage.

1.2, HISTORY

In early 2001, Arturia began working on advanced algorithms for the digital emulation of
analog circuit audio characteristics. They are known as TAE®, standing for True Analog
Emulation. In non-technical language, this is an unprecedented way of creating the very
unique sound one finds in a synthesizer such as the Moog Modular. Nearly a year after
they began work on the algorithms, Arturia was ready for feedback. At the 2002 NAMM
show in California, Arturia shared an early version of what would later be the Moog
Modular V with the renowned maker of the original Moog synthesizer, Doctor Bob Moog.

In seeking insight from sound production experts, such as Dr. Moog, as well as avid
synthesizer users, Arturia was able to ensure the quality of the instruments they made;
so well in fact the Dr. Moog himself endorsed the Moog Modular V. The launch of this
sound powerhouse was an instant success, winning awards from several top magazines,
and leading to the development of other synth recreations.

Shortly thereafter, Arturia started receiving many requests from musicians, producers
and bands. Many of them explained how they were planning to replace their original
hardware synthesizers by virtual instruments. Artists around the globe were beginning to
see the advantages of a software alternative to hardware-based synthesizers.

The CS-80V emulated the legendary Yamaha CS-80, considered by many as "the
ultimate polyphonic" synthesizer, and was launched at the AES 2003 in New York.
Imagine some of your favorite music from diverse artists such as Keith Emerson or
Stevie Wonder, and you'll get an idea of what the CS-80V is capable of.
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The ARP 2600 V was launched at the NAMM 2005 in Anaheim. This is a faithful
reproduction of the ARP 2600 and is great for just about any sound one might wish to
create: everything from drum n’ bass stabs to Star Wars’ R2-D2 sounds have been made
with the ARP.

At the Winter NAMM Show 2006, ARTURIA announced the release of its seventh product:
the Prophet V. This powerful hybrid gives you two instruments in one: it combines the
warmth of the legendary Prophet 5 programmable analog synth with the unique Vector
Synthesis textures of the digital Prophet VS.

And finally, at the summer 2007 NAMM Show, Arturia launched the Jupiter-8V. In terms
of sonic possibilities, it complemented its “Arturian siblings” by bringing something
different. The Jupiter-8 V was capable of creating very versatile sounds. You could easily
make 'fat' or ‘Crystal’ sounds with it. In fact, the Jupiter-8 sounded the way it looked,
‘sleek and polished".

The electro-pop community became quickly convinced by the qualities of the original
Jupiter-8. 'Relax’, by Frankie Goes to Hollywood was produced incorporating a Jupiter 8,
and players such Vince Clarke, John Foxx, and Martyn Ware also used it abundantly. The
path to classic status of the Jupiter started there.

Other artists that have used The Jupiter-8 include: Howard Jones, Tangerine Dream,
Underworld, Jean Michel Jarre, Depeche Mode, Prince, Gary Wright, Adrian Lee, Heaven
17, Kitaro, Elvis Costello, Tears for Fears, Huey Lewis and the News, Journey, Moog
Cookbook, Yes, Devo, Freddy Fresh, Simple Minds, Jan Hammer and BT.
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2 INSTALLATION

2.1 WINDOWS INSTALLATION (7/XP/VISTA)

* Place the Windows®-specific installation DVD in your computer's DVD-ROM
drive.

e Use Windows® Explorer to browse the content of the DVD-ROM.
* Double-click the installer file named SPARK Setup.exe.
*  Click Next.

« To continue, you need to first accept the license agreement. After you have
read the license agreement, check the corresponding checkbox and click
Next.

e To perform a complete installation, leave the Complete option checked and
click Next. To deselect components or to install the SPARK application and
sound library to an alternative location, select Custom. Then click Next. In
the next dialog, choose the destination folders for the installation. To use the
default path, just click Next. If you wish to select a custom path for a SPARK
component, click Change, browse to the folder where you want to install the
application or sound library. Then click Next. If you select VST (and/or VST
64 bits) you will have to select your VST (and/or VST 64 bits) folder.

e The Setup Program will lead you through the installation procedure. Follow
the onscreen instructions.

e After the installation has been performed successfully, click Finish.

* Next, in order to install the SPARK Controller hardware driver, you need to
connect the SPARK Controller to your computer. On Windows® Vista, the
driver setup will finish automatically. On Windows® XP, installation is a two
step process, described below. The following screen should appear:

e Installation starts with Composite Device install:

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update “Web site [with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

() Yes, this time only
() Yes, now and every time | connect a device
() No, not this time

Click Next to continue.

[ Next > ][ Cancel J

* Choose “Yes this time only”, and click next.
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Found New Hardware Wizard

This wizard helps you install software for:

USE Composite Device

') If your hardware came with an installation CD
~~ or floppy disk. insert it now.

What do you want the wizard to do?

(@) Install the software automatically (Recommended)
(O Install from a list or specific location [4dvanced)

Click Nest to continue.

< Back ][ Next > ][ Cancel

*  Click next.
e After processing, Composite Device will be installed correctly.

. Installation should continue with USB Audio Device install.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

O Yes, this time only

Qv

d every time | connect a device

Click Next to continue.

[ Next > ] [ Cancel

e Choose “No, not this time”, and click next.
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Found New Hardware Wizard

This wizard helps you install software for:

USE Composite Device

\ ') If your hardware came with an installation CD
~” or floppy disk. insert it now.

What do you want the wizard to do?

) Install the software automatically (Recommended)
(%) Install from a list or specific location [Advanced)

(e

Click Next to continue.

[ < Back ” Next > ][ Cancel l

* Choose “Install from a list or specific location”, and click next

Found New Hardware Wizard

Please choose your search and installation options. \\

N

() Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

(®) Don't search. | will choose the driver ta install

Choose this option to select the device driver from a list. “Windows does not quarantee that
the driver you choose will be the best match for your hardware.

[ < Back “ Next > ][ Cancel l

e Choose “Don't search, I will choose the driver to install”.
e Click Next.
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Hardware Update Wizard

Select the device driver you want to install for this hardware. \\

¥

@ Select the manufacturer and model of your hardware device and then click Nexst. If you
/) have adisk that contains the driver you want to install, click Have Disk.

Show compatible hardware

Model
¢ USB Sudio Device

5 This driver is digitally signed.

Tell me why driver signing is important

< Back ][ Next > ]’ Cancel ]

. Click “Have Disk”

*  Click Browse, and locate Spark_XP.inf on Spark install DVD :
[YourDVDdrive] : \Driver\Spark XP.inf

Hardware Update Wizard

Select the device driver you want to install for this hardware. \\

&

@ Select the manufacturer and model of your hardware device and then click Next. If you
Z) have a disk that contains the driver you want to install, click Have Disk.

Show compatible hardware

Model
-‘w" Spark Controller

:J This driver is digitally signed.

Tell me why driver signing is important

[ < Back l[ Next > ]’ Cancel l

*  Choose “Spark Controller”, and click Next
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Hardware Installation

! E The software you are installing for this hardware:
L
Spark Controller

has not passed Windows Logo testing to verify its compatibility
with Windows XP. [Tell me why this testing is important. )

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either inmediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

Continue Anyway ] EﬂéTUF’lnstallation |

e Click “Continue Anyway”.

Your Spark Controller should now be ready to use.

2.2 MAC OSX INSTALLATION (10.5/10.6)

* Place the installation DVD-ROM in your computer's DVD-ROM drive. Its icon
will appear in the Mac OS® X Finder.

Connect the SPARK Controller using the USB cable. If you want to connect
the Controller to a USB-hub instead, make sure the hub has its own power
supply. SPARK's Controller will not work on a passive (bus-powered) USB
hub.

*  Double-click the SPARK DVD icon to display the content of the DVD.
* Double-click the installer file named SPARK.
e Click Continue to proceed.

* To continue, you need to first accept the license agreement. After you have
read the license agreement, press Continue and click Agree.

e Select the hard disk onto which you would like to install SPARK. Please note
that you can only install SPARK onto hard disks which contain a Mac OS® X
version matching the system requirements. Hard disks with an incompatible
Mac OS® X version will be flagged with a red Stop sign and you will not be
able to select them from the Installation Destination dialog. From Mac OS® X
10.5 on, this screen will be skipped automatically.

. Click Continue.

* Select the elements you want to install (we recommend installing all
elements, however if you know that you don’t need a certain element like a
plug-in format, uncheck the checkbox next to it).

 If you want to install the SPARK Library contents to a custom location, e.g. to
an external hard disk, click the folder icon in the Location column to open a
dialog in which you can specify a destination for the installation.

* Click Install to continue. The Setup Program will lead you through the
installation procedure. Follow the onscreen instructions.
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3 REGISTRATION & AUTHORIZATION

3.1 REGISTRATION

Now that your SPARK Software has been installed, the first step is to register your
software in order to obtain the activation code that will enable you to actually use the
software.

You should have handy the license serial number of SPARK Software and the unlock code
(these are an integral part of the software and are printed on a small plastic card).

Connect your computer to the Internet, and go to this web page:

http://www.arturia.com/login

If you don’t have an Arturia account yet, please create one now. This will take you to
this form:

Create your account here

* Indicates required fields

Firstname: *

Lastname: *

Email address: *

Confirm email: *

Password: *

Confirm password: *

Address:

City:

State:

Zip/Postal code:

Country: * ‘_ _:]

1 wish to receive the Arturia newsletter: @

If you already have an account, simply log in:

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 18



Once you are logged into
activation code.

Go to the “My Registered
button:

Already have an account ?

Email address: [| J

Password:

Remember me: D

Forgot my password?

Want to create an account* ? Click here

your account, you can register your Spark and request your

Products” section of your account and click on the “Add”

My Registered Products

You don't have any license !

STEP BY STEP GUIDE

How to authorize my -
virtual instrument? ~ .~

Add

This guide details the full process to virtual instrument authorization.
It consists in 2 major steps:

« 1. Register your synthesizer on your Arturia account
e 2. Download a license on your eLicenser dongle (being virtual or hardware)

In the form that appears, s

elect "SPARK Software” from the drop down menu, and key in

your software serial number and unlock code (as written on the registration card), and

click Submit:

My licenses
You don't have any license !

Add a license

Product: *

Serial number: *

Please use :

Unlock Code:

Co b))
[ Submit

XXXXXXXX - Only if printed on your registration card !

) (C: 1)
)| Cancel )

You should then see the confirmation screen, click Submit:
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Please confirm the following information:

« E-mall address : youremail@yourprovider.com
» Product : Spark
« Serial Number : 1234567812344569

_Submit_ _Cancel

3.2 AUTHORIZATION
Finally there is a screen to copy the activation code. The very same information is sent
to you by email as a backup.

Copy the activation code and paste it in the window that shows when you launch
SPARK:

Spark Authorization

Thank you for using Arturia's Spark Creative Drum Machine.
This software has not been authorized yet on this computer and
will run in Demo* mode until the full authorization to be
completed.

To fully operate this software, please enter the Authorization

If any doubt, please refer to the adequate chapter in your Spark
User's Manual.

Activation Code:

* When Spark is running in Demo mode, all saving and export capabilities have
been disabled.
For details about purchasing this software, please visit our website.

If your activation code has been entered correctly, the software will launch.
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4 QUICK START

4.1 SPARK CONTROLLER OVERVIEW

SECUTNCER

'@ullllllllllllllqg
LIITY ‘

1. Digital Display

2. Sequencer zone

3. Song/Pattern zone

4, Jog dial

5. FX live Pad

6. Instruments control zone

Connect the SPARK Controller using the USB cable. If you want to connect the Controller
to a USB-hub instead, make sure the hub has its own power supply. SPARK's Controller
will not work on a passive (bus-powered) USB hub.

4.2 SPARK SOFTWARE OVERVIEW
This chapter will introduce you to the SPARK software’s user interface elements. If you

need to look up a certain user interface element’s name, you can return to this chapter
at any time for a refresher!
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Spark's user interface is divided in three main panels called: "TOP", "CENTER" and

"BOTTOM".

4.2.1 The Center panel

When launching SPARK, the CENTER PANEL will appear by default.
r -

)| | [ B

JQ

Bass Drum Snare Drum Closed Hi-Hat Open Hi-Hat Clap Hi-Tom Mid-Tom

1. Digital Display

2. Sequencer zone

3. Song/Pattern zone

4, Jog dial

5. FX live Pad

6. Instruments control zone

4.2.2 The Bottom panel

The Bottom panel features the Studio, the Mixer and the Library.
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1. Studio Button

2. Display Instruments 1 to 8
3. Display Instruments 9 to 16
4, Display all Instruments

5. Mixer button

6. Library button

4.2.3 The Top panel

The Top panel features the Pattern, the Song and the Library interface.
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1. Pattern button
2. Song button
3. Preferences

4.3 NAMES AND CONCEPTS YOU SHOULD KNOW

This chapter will introduce you to SPARK's terminology and explain how these different
elements relate to one another.

4.3.1 Project

A Project contains all data needed for a Song: a 16 instrument kit and up to 64 Patterns
with their settings, automations and FX.

4.3.2 Kit
Each kit is made up of 16 instruments, i.e. Bass drum, Hi-hat, etc.

You will find all of the instrument Kits in the Library, under the project window (Bottom
panel).

4.3.3 Instrument

An instrument is a sound generated from an audio source assigned to a track pad. For
example, you can assign the instrument Bass Drum to track 1, which you will then hear
when hitting the bottom left pad in the main panel.
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4.3.4 Audio Source
Sample (.wav, .aiff audio files)
Physical (Physical parameters)

Analog (Vintage drum machines with analog parameters)

4.3.5 Bank
SPARK features 4 banks of 16 MIDI patterns each, called A-B-C-D.

Go to the main panel, click on "A" and then "1" in the Song/Pattern zone. Then click on
the play/pause button: you will hear the pattern number 1 of Bank A.

4.3.6 Pattern

A Pattern is a sequence of notes played by instruments.

4.3.7 Song

A Song is an editable ordered sequence of several patterns that defines your song
structure.

SPARK allows songs made of 64 patterns maximum.

4.3.8 Channel
A specific channel is assigned to each instrument in the Mixer.

The channels are numbered from 1 to 16 in the same way the instruments are.

4.3.9 Track

The pattern window in the Top Panel shows you the 16 instrument tracks. Each track is
the score played by one instrument.

4.4 AUDIO AND MIDI SETUP

4.4.1 Windows

To access the preferences window, click on the SPARK menu > Setup > Audio & MIDI
Settings. This window allows you to configure the global preferences of SPARK. These
are saved automatically.

4.4.2 MacOS X

To access the preferences window click on the SPARK menu>Preferences. The Audio
settings window will appear. This window features the global preferences of SPARK.
These are saved automatically.

For further details on how to setup Audio and MIDI, please refer to Chapter6 : MODES
OF OPERATIONS of this manual.
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4.5 FIRST STEPS WITH SPARKO

4.5.1 Loading a project

To load a project, go to the tool bar and click on LOAD.

80's Studio Drums

Move your cursor over "Factory Project" and click on a project in the drop-down list, for
example "FUNK".

This project is now loaded into SPARK and its name appears in the window next to the
button "SAVE".

4.5.2 Select and play a pattern

To select and play a pattern, move your cursor to the "Song/Pattern" zone and choose a
Bank of patterns, for example the BANK A (click on "A") and a pattern in BANK A, for
example pattern #1 (Click on "1"). You will notice that your selection is now highlighted.

BBBEBEET X*)

Now, go to the transport zone and click on the "Play/Pause" button to listen to Pattern
#1 in Bank A. To listen to a different pattern, just click on another pattern number. You

1 When reading "Click" for the software version of SPARK, replace by "Press" for the Hardware version or refer
to chapter 7 of this manual: THE SPARK MIDI CONTROLLER.
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do not necessarily need to stop playing a pattern to listen to another. The same applies
to switching from Bank to Bank.

4.5.3 Change Instrument parameters

The three knobs above each of the instrument's pad are the instrument's parameters.
Let's try and change the pitch of the snare drum. While the pattern is playing, place your
cursor over the "Pitch" knob, click on it and while maintaining your click and move your
cursor up and down slowly. This will turn the "Pitch" knob up and down. Listen how the
pitch of the Snare drum is changing. The Digital display window in the center of the main
panel shows the changes applied to the Pitch (number of semitones).

Bass Drum Snare Drum Closed Hi-Hat Open Hi-Hat

4.5.4 Select an Instrument and change filter and mixer parameters

To select an instrument, for example the snare drum, move your cursor to the dividing
line above the 2" pad from the left called "Snare Drum". The dividing line is to the right

of the instrument and will be highlighted to let you know that you have entered its
selection zone.

Click once. The "Snare drum" pad is now lit as well as the red LED. The instrument
"Snare Drum" is now selected. Alternatively, hold the Select Button and press an
instrument pad to select it.

Bass Drum Snare Drum Closed Hi-Hat Open Hi-Hat

To change the filter and/or the mixer parameters, first select an instrument and simply
click on one of the filter or mixer parameter buttons. While holding your click, move your
mouse up or down to change the parameter's value. The Digital display window in the

center of the main panel shows you the changes applied to the selected parameter in
real time.
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Creative Drum Machina

4.5.5 Play and edit a pattern

To play a pattern use the Play/Pause button located in the upper left corner of the
CENTER PANEL interface.

To edit a pattern, you will use the 16 small pads located at the top of the main panel.
You will notice that when you play a pattern, the current playing position is shown with a
lit pad in real time. When a pad lights up, it means that the sequencer will play a MIDI
note-on (a beat) at this pattern's position. If a pad is not lit, it means that no note will
be played, therefore no sound will be heard. You can trigger a note-on or remove it by
pressing these pads.

To better understand, click on Bank A / pattern #1 and then select the snare drum
track:

Look at the 16 small pads at the top of the main panel: some pads are lit and others are
not. The ones lit are the note-ons, those unlit are not triggering note-on messages.

SEQUENCER

Every lit pad is a Snare drum's beat. You can edit this track by pressing a pad to add or
remove a note-on. Try it! While the pattern plays, click on pads 2, 3, 4 and 5. They
are now unlit, therefore you do not hear any snare drum beats any more. Now click on
pads 1 and 4: you are starting to compose your own pattern.

4.5.6 Record a pattern with instrument pads

To do so, we will start by erasing the current pattern and start from scratch.

First, click on the "ERASE" BUTTON, right above the digital display window and then go
to the Song/Pattern zone and click on the currently selected pattern - it should be
Pattern #1 of BANK A:
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Divide

Frnk

The pattern #1 of Bank A is now erased. The 16 editing pads are not lit anymore (since
the snare drum track is now empty as well as all the other instrument tracks). Click on
Pattern #1. We are now ready to record a new pattern #1 with the instruments pads.

To use the Metronome, click on the Metronome Button, set its volume and proceed with
recording your pattern. Clicking on the Metronome button again will switch the
metronome off.

Click on the pad called Bass Drum at the bottom left side of the Center panel. You are
now playing bass drum. To record a Bass drum, click first on the record button and then
on the play button, the recording has now started.

Play your Bass drum part on the Bass Drum pad and then click stop. By clicking "Play",
you will now listen to the track you just recorded. To record another instrument, select
another instrument track (If you forgot how to do this, go back to 4.5.4. Select an
instrument) and repeat the same steps to start recording.

4.5.7 Change Instruments/Kits with the jog dial

To change an instrument with the Jog Dial, you need to first select the instrument you
want to change. Now, go to the Song/Pattern zone. Click above the Jog Dial where it
says: "Instrument". Click on the Jog Dial and while holding your click, move your mouse
up or down to select a new instrument. The name of the instrument will be displayed in
the Digital display window in the center of the main panel. Once your choice is made,
click on the Jog Dial to load the new instrument.

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’S MANUAL 29



The procedure to change a Kit is the same, except that you do not need to select an
instrument since you're loading all of them. Just click below the Jog Dial where it says:
"Kit", and follow the same procedure as with the instrument selection.

4.5.8 Save your project

To save your project, go to the toolbar and click "Save". A drop down menu will appear.
Choose "Save as...”

1800

Give a name to your project and choose a style from the drop down menu. Click "OK".
Your first project is now saved. Congratulations!

The name you gave to your project is now showing in the display window next to the
button save.

4.5.9 Switching views

SPARK's interface is made up of 3 main panels. The "TOP" panel, the "CENTER" panel,
and the "BOTTOM" panel. Up until now, you have only been introduced to the main or
"CENTER" panel.

You are now ready to discover everything SPARK has to offer.
To show the "TOP" panel, go to the toolbar and click on "TOP".
To show the "BOTTOM" panel, click on "BOTTOM"

All 3 panels are now showing, you can scroll up and down to go from one panel to
another.
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5 USING SPARK

5.1 THE TOOLBAR

10.

11.

12.

13.

Load button

Save button

New Project window/Quick Load Menu (Most recently
opened projects)

Set Metronome volume button

Set Metronome on

Open or center "TOP" panel in the main window
Open or center "CENTER" panel in the main window
Open or center "BOTTOM" panel in the main window
Connect Hardware

CPU Meter

Main volume meter

Clipping indicator

Set Soft clip on/off
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5.2 THE MAIN PANEL (OVERVIEW)?

I =

(’j) SEQUENCER

I!!l!!ll!ﬂﬂ!ﬂﬂﬂﬂ 2 Q

=12 SPARK

Creativf 7 Yn Machine
7

Bass Drum Snare Drum Closed Hi-Hat Open Hi-Hat Clap Hi-Tom Mid-Tom

1. Play instruments with Pads (Right click: Edit instrument)

2. Instrument parameter knobs
(Right click: edit motion/disable motion)

3. Instrument Select Button (Hold select, then press an instrument pad.)
4 Instruments page Button (Instrument 1-8 and 9-16)

5. Mute Button (Click on mute, then on instrument(s).)

6. Solo Button (Click on solo, then on instrument.)

7. FX - Aux 1 and 2 - Pan and volume Knobs

(Right click: edit motion/disable motion)

8. Click zone to select instrument track

2 When reading "Click" for the software version of SPARK, replace by "Press" for the Hardware version or refer
to chapter 8 of this manual: THE SPARK MIDI CONTROLLER.
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FX display window

10.

Filter Button (Right click: Always on/only on touch)

11.

Slicer Button (Right click: Always on/only on touch)

12.

Roller Button (Right click: Always on/only on touch)

14.

Jog Dial (Right click: Instrument mode/Kit mode)

15.

Bank select Buttons (A-B-C-D)

16.

Pattern select Buttons (1 to 16)

17.

Instrument select Button

18.

Kit select button

19

Song select Button
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20. Record button (Right click to select quantized/unquantized recording)
21. Stop Button
22. Play/Pause Button
23. Tap Button (Tap tempo)
24. Tempo knob (Change Tempo)
25. Display previous/next 16 pattern steps
26. Set accent mode Button (On patterns or steps)
27. Erase/Cancel Erase Button
(Use to erase Instruments or Patterns)
28. Divide loop size knob
29. Loop On/Off Button
30. Move loop locator knob

(Right click: Shift by one step/Shift by one loop size)

31. | Sequencer Steps: ON/OFF pads
32. | Shuffle knob

(Right click: Swing range / velocity mode)
33. | Master volume knob
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5.2.1 The Digital display

Mew ProJdect

N
SPARK

Creative Drum Machine

The digital display is of an invaluable help. It displays all the information needed while
using SPARK. (i.e. Project name, precise changes applied when using Volume knob, FX
knobs, etc.)

5.2.2 The Sequencer zone

stoutncen

The Sequencer zone is divided into several zones:

5.2.2.1 The Step Pads

16 Step pads numbered from 1 to 16.

These pads allow you to edit your pattern by triggering note-on messages on your
instrument track. Patterns have a maximum number of 64 steps. If your pattern has
more than 16 steps, use the << or >> buttons to navigate to the previous or next page.
If you click on the >> next page button, you will see the numbering on the pads switch
from 1-16 to 17-32 for the second page, and so on.

You may choose to follow the cursor as it advances on the step pads (the pages will
change automatically) by right clicking on the >> button. A contextual menu will appear
allowing you to check or uncheck the “follow current step” option. If this option is
activated, both << and >> buttons will be lit. If the follow option is deactivated, the
buttons will not be lit up.

The step resolution is a sixteenth of a note by default. You can change the resolution in
the pattern panel. (See Chapter 5.4.3)
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5.2.2.2 The Shuffle Knob

This knob sets the amount of shuffle applied to a pattern. Shuffle is a rhythmic shifting
of a Pattern in which the first note in a series of two plays for a longer time than the one
that follows.

When the Shuffle knob is turned all the way up, the first note in a series will play twice
as long as the one that follows.

Right click on the shuffle button to set the swing range (1/4, 1/16, 1/32 of a note). This
will define the value of the note on which the swing will be applied.

Click on velocity mode to apply shuffle to the note velocity.

Shuffle is a function better heard than described. Try it!

5.2.2.3 The Transport Zone

These buttons, from left to right, are:
* Record
» Stop
. Play/Pause

To record, click on the Record button and then on the Play/Pause button. The Record
button will turn to red to indicate recording mode is on.

To stop recording, click on the Stop button.
To disable recording mode, click on the Record button again.

While a pattern plays, clicking on the Play/Pause button will pause the playing. Click
again on Play/Pause to resume playing.

Click on Stop to reset current position to the beginning of the pattern.

Right-click on the Record button to choose between quantized or unquantized recording
function.

v~ Record quantized
Record unquantized

In Quantize mode; the recorded notes will be set exactly to the nearest step position.
When quantize mode is disabled, the recorded notes will keep the exact position they
were played on. Spark uses the Shift parameter (see Chapter 5.4.5) to remember the
exact triggering time relative to a step position.
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5.2.2.4 The Tap Button

TAP

The Tap button allows you to define the tempo of your pattern by simply tapping this
pad at the desired tempo. It is a beat/minute counter, so you have to tap the beats.

5.2.2.5 The Tempo Button

Tempo

The Tempo knob allows you to set the tempo for your pattern when SPARK is not
externally synced to a host. Hold Select and turn Tempo knob to temporarily increase or
decrease the tempo, as you would push or pull a turntable, in order to synchronize Spark
to an external audio source.

5.2.2.6 The Accent Button

Accen(l

The accent button allows you to set accents onto steps. Setting accents is very similar to
writing a "forte" on a music score. The accented steps will be played with more strength
that the unaccented ones. This allows for a very "natural" feel when listening to a
pattern.

Click on the accent button to set the sequencer steps to Edit accent mode. Now the
sequencer's steps in the main panel show the accents set on steps (not to be confused
with the note-ons in the normal Step mode).

Set an accent by clicking on the step: the step will light up. Remove the accent by
clicking on a highlighted step.

To exit accent mode, click on the accent button again.
Accent ON sets velocity to 127, Accent OFF sets velocity to 64.

Click on the erase button to set Erase mode.

5.2.2.7 The Erase Button

You can erase Instruments, Banks or Patterns.

For example, to erase pattern 1 in Bank A, make sure Bank A is selected then click on
Erase and then on 1 in the Pattern section.
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5.2.2.8 The Loop zone

Click on the button "ON" to set Loop mode on.
The Divide knob allows you set the loop size.
Moving the knob one notch will halve the loop size.

The settings are 1/2, 1/8 and 1/4 of the pattern size, all the way down to the minimum
loop size: one step.

The Move knob allows you to move the loop start in one of two ways. Using “Shift by one
step” mode will shift the loop start to any given step of the pattern (stepwise).
Alternatively, you can move the loop in increments of the loop size (defined with the
divide knob) by using "shift by one loop size" mode. Right click on the Move knob to
choose the Move Loop mode: “Shift by one step” or “Shift by one loop size”.

] v Shift by one step
Shift by one loop size ¢

5.2.3 The Song/Pattern zone

The Song/Pattern zone is where you can trigger the Song mode, select and play your
patterns, load Instruments or load a kit into your project.
5.2.3.1 The Song Mode

A Song is made up of a maximum of 64 patterns chained together. Click on the Song
button to enter the Song mode. The Song button will flash continuously to let you know
that you are now in Song mode. Click on the Play button in the transport zone.

Listen! Your patterns are now chained together and played one after another from
pattern to pattern and Bank to Bank.
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The Step pads (numbered from 1 to 16 at the top of the Center Panel) light up as each
pattern is being played. They show you which pattern is currently being played.

To edit your Song, refer to Chapter: 5.4.6 The song panel

5.2.3.2 Editing Songs from the Main panel

As we have just seen, a Song is made up of several patterns chained together. The order
in which each pattern is played can be changed from the main panel.

When in Song mode, each step pad, numbered from 1 to 64 represents the position
occupied by a pattern in the chain (to select the next page, click on the next 16 steps
page button >>).

When the Song plays, the step pads will light up successively showing you which pattern
is currently being played in the chain.

The number under the step pad represents the position of a given pattern in the chain.
This number has no relation whatsoever with the pattern number. For example, you can
decide that the pattern B-12 will be played first, then pattern A-1, and so forth.

To edit a song, first of all make sure you've selected the Song mode by clicking on the
Song Button. The song button should blink.

Then, press the record button in the transport zone. You are now ready to assign a
location to your patterns in the chain.

Let's say you want pattern A-2 to be in first position when playing the song. Click on
Step pad #1 and then, in the Song/pattern zone, click on Bank A then on pattern 2.
That's it. When you will play your song, pattern A-2 will be the first pattern of your song.

Repeat this operation to create your song. Remember to click on the next or previous 16
pattern page button [>> or <<] to go to the next or previous page.

5.2.3.3 Banks and Patterns

The patterns are organized in 4 banks (labeled from A to D) of 16 patterns each
(numbered from 1 to 16).

To select pattern number 6 of Bank B, click on Bank B and then on pattern 6. The
selected pattern can now be played when clicking on the Play button in the transport
zone.

But you can also use the Song/Pattern zone to copy or swap patterns in the currently
selected Bank.

To copy a pattern, drag and Drop a pattern number while holding [Option/Alt] on Mac
OSX or [Ctrl] on Windows and drop it on another pattern number. A pop-up menu will
ask you to confirm your choice. Click Ok.
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In this example, Pattern 1 is being copied to pattern 13.

To swap patterns, simply drag and Drop a pattern number onto another one. A pop-up
menu will ask you to confirm your choice.

The exact same procedure applies to copying or swapping Banks.

5.2.4 The Jog Dial

The Jog Dial allows you to load Kits, Instruments or projects when working on an open
project. You may choose (via the preferences tab in the upper screen) to assign the Jog
dial to switch between either Instruments and Kits using the “Switch from Instrument to
Kit Mode”, or else between Instruments and Projects using the “Switch from Instruments
to Projects Mode”. By default Spark is set to “Switch from Instrument to Kit Mode”.

To load a kit (or Project, depending on preference settings), click on "Kit" under the Jog
Dial. Click on the Jog dial and while maintaining your click, move your mouse up or down
to select a kit.

The kits name will appear in the center display window. Then, click on the Jog dial again
to load a new Kkit.

To load a new instrument to an instrument pad, first select the instrument pad you want
the instrument to be assigned to. Then, click on “Instrument" above the Jog dial. Next,
click on the Jog Dial and while holding move your mouse up or down to select a different
instrument. The list of Instruments will appear in the center display window. Select an
Instrument and then click on the Jog dial once again to confirm your selection.

You may switch between Kit and Instrument modes by either clicking on their names, or
else by right clicking on the Jog Dial. A contextual menu will appear and allow you to
choose between the two Jog Dial modes.

The new instrument is now assigned to the previously selected Instrument pad; the new
instrument's name appears below the pad.

The instrument list is organized this way:
*  Same type first (BD, Snare,...)
*  Other types but same style (Rock, etc...)
e Other types.
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5.2.5 The FX Live Pad

m

Slicer

The FX live pad is a striking tool, especially if you plan on playing live. Its touch sensitive
screen will apply live effects in real time to your song or patterns, allowing you to shape
your sound with great precision. When your cursor enters the FX pad zone, it turns from
an arrow to a cross.

The FX Pad features 3 main effect buttons called Filter, Slicer and Roller. By right clicking
on any of them, you can choose between: "Latch" or "Touch". "Latch" will not cut off the
effect when releasing your click, the "Touch" option will cut off the effect upon releasing
your click: the effect is only active when the Pad is touched/clicked on.

5.2.6 The Filter / Slicer / Roller

5.2.6.1 The Filter Button

The Filter button offers a Low pass, a Band pass and a High pass filter with cutoff and
resonance.

To select Low pass, Band pass or High pass, click on the FILTER button repeatedly. Your
choice will be displayed on the center display window.

The Cutoff and resonance can be modulated with the mouse on the software version or
your finger on the hardware version.

The resonance is modulated vertically from the bottom of the pad to the top of the
pad.

Cutoff is modulated horizontally, from the right side of the pad to the left side of the
pad.

Play a pattern of your choice and click anywhere on the right edge of the FX pad while
maintaining your click; draw a straight horizontal line towards the left side of the FX pad.
You will hear the cutoff modulating. The amount of modulation applied can be seen on
the center display panel.

Now place the cursor close to the bottom right corner of the FX pad and trace a line
straight up to the top edge of the pad. You are modulating the resonance.

Of course, both Cutoff and Resonance can be modulated simultaneously by moving the
mouse in any direction and at any speed you wish.

5.2.6.2 The Slicer button

The Slicer will repeat the value of the note selected while applying an effect. You can
choose between the following effects:
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Filter

Repeat mix

Click to choose the value of the note to be repeated with the Repeat mix effect. The
effect will be applied for the amount of time your mouse click is maintained. Release
your click to cancel and resume normal playing.

Repeat mix will continue playing the pattern while the effect is applied.

Repeat

The Repeat effect is the same as Repeat mix, except the pattern is not played while
applying the effect.

Tape

The Tape effect simulates the effect of slowing down a tape player.

Reverse

The Reverse effect simulates the effect of playing a tape recording backwards.

Strobe

The Strobe effect will play and shut off the sound alternatively at the rate of the selected
note value.

Pan

The Pan effect will move the sound from the left speaker to the right speaker at the rate
of the selected note value.

Bit Crush
The Bit Crush effect allows you to reduce the audio bit rate, creating a Bit Reduction or
Bit crushing sound effect. Reduce the audio anywhere from 7 down to 2 bits.
5.2.6.3 The Roller button

The roller could be described as a "Drum roll" tool.

Filter

Slicer

Roller

Choose the note value for the Roller effect. Then, click and maintain your click on the
snare drum pad. The snare drum will play a basic drum roll. The roll speed depends on
the selected note value.
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You can play, of course, any instrument pad using this effect.
The beginning of the roll is quantized by default.

A swing effect can be added by simply clicking on the upper note values for Swing on, or
on the bottom values for Swing off. When swing is off, one beat is played per note value.

When Swing is on, a beat is added before the second beat resulting in playing close to a
triple time bar.

5.2.7 The Instrument control zone

Bass Drum Snare Drum Closed Hi-Hat Open Hi-Hat Hi-Tom Med-Tom Low-Tom Closed Hi-Hat

The instrument control zone is made up of:

5.2.7.1 The instrument Pads

There are 16 instrument Pads but only 8 of them are shown on SPARK's interface. To
navigate to the next set of 8, click on the 1-8/9-16 button.

An instrument is assigned to each pad. The far left pad is by default the Bass Drum, next
to it is the Snare drum, and so on; but you can of course personalize this arrangement.

To edit an instrument, right click on the pad, and then Click on edit. This will take you to
the "STUDIO" bottom panel where you will be able to edit a full array of instrument
parameters. (See next chapter 5.3.1 The Studio).

5.2.7.2 The Parameter Knobs
Each instrument pad has 3 parameter knobs above it.

These parameters act on the sound generator to modify the sounds in real time so as to
give each sound its own color. Each instrument has 6 parameters (3 of which are
mapped to the knobs).

You may choose which parameter each knob modifies by clicking on the name
underneath the knob. A contextual menu will appear listing the 6 parameters available in
addition to the Filter, Mixer and available Fx parameters (if an effect is set as insert on
the instrument’s mixer track). Click on a different parameter name to assign the knob to
that parameter.

Common instrument parameters are tuning/pitch, filter cutoff envelop decay, attack and
release, different effect depths and rate (ring, shift, etc).

Filter parameters are Cutoff and Resonance. You can set the filter type for each
instrument in the studio panel.

Mixer parameters are Aux1 effect amount, Aux2 effect amount, Panning and Volume.

Fx parameters depend on the chosen insert effect set on the instrument mixer track.
Each effect has its own parameters exposed as well (dry/wet, feedback, delay time...)
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You do not need to select a specific instrument to change its parameter. Any effect is
applied in real time while the pattern is playing.

The parameter motion can be recorded as an automation into the pattern and edited
later accurately using the automation graphic editor. (see chapter 5.4.5 ).

Right click on a parameter knob to edit the corresponding automation. You can also
choose to momentarily disable a Motion parameter in this way.
5.2.7.3 Select Button

The Select button allows you to easily select an instrument. Just click on [Select] and
then on the instrument pad of your choice to specifically select the corresponding
instrument.

This function was designed to quickly select an instrument when using the Spark
controller.

5.2.7.4 1-8/ 9-16 Button

The main panel interface shows 8 instrument pads while a kit contains 16 instruments.

To navigate to the next set of 8 instruments, click on this button.

5.2.7.5 Mute button

This button allows you to bypass the audio sound of a specific instrument. Click on the
Mute button and then choose the instrument you wish to mute. You will no longer hear
that instrument when playing your pattern. When in mute mode, you can select multiple
instruments to mute them together.

5.2.7.6 Solo button

The Solo button mutes the other instruments besides the one(s) selected. Click on the
Solo button and then choose the instrument you wish to solo. You will only hear that
instrument when playing your pattern. When in solo mode, you can select multiple
instruments in order to solo them together.

5.2.7.7 Filter/Mixer parameters

A specific filter is applied to each instrument of a kit. The filter type can be changed in
the Studio Edit instrument view. (See next chapter 5.3.1 The Studio).

To change the filter and/or the mixer parameters, first select an instrument and simply
click on one of the filter or mixer parameter knobs and while maintaining your click,
move your mouse up or down to change the parameter. The Digital display window in
the center of the main panel shows you the changes applied to the selected parameter in
real time.

These motion parameters can be recorded as automations into the pattern and edited
later accurately using the automation graphic editor. (See chapter 5.4.5).

Right-click on a Filter or Mixer knob to edit or disable its Motion.
*  Cutoff: Set Filter cutoff on current instrument
* Resonance: Set Filter resonance on current instrument.
. Aux1/Aux2: Set Auxl or Aux2 amount on current instrument.
* Pan: Set amount of Pan on current instrument.

. Volume: Set the volume on current instrument.
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5.3 THE BOTTOM PANEL (OVERVIEW)

The Bottom panel features the Studio, the Mixer and the Library.

To access the Bottom panel from the Main panel, go to the toolbar and click on
"Bottom".

Right click on the picture to change the background. A pop-up menu will let you choose
between:

* No background
*  Classic drums

*  Electronic drums
e  Physical drums

. Electro box
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5.3.1 The Studio*

INSTRUMENTS 1-4 INSTRUMENTS 5-8
1 Bass Drum
Funk Drums_BD (Bass Dr... v

f{rturlo

The studio panel displays all your instruments as well as their parameters.

From here you can load instruments into slots, apply filters and effects, etc.
The picture above shows the 1-8 instrument view.

Let’s look at the Bass drum window:

INSTRUMENTS 1-4

1. Load a new instrument

To load a new instrument, click on the down arrow. A drop-down menu will
appear listing all the instruments available in Spark. They are organized by
type (16) from Bass Drum to Synth, and each type has 3 categories
(Analog, Physical Model or Sample). Choose a new instrument in the list and
click on its name.

2. Instrument icon

Clicking on this icon will trigger the instrument's sound. You may drag the
icon to another instrument icon to make a swap operation or hold Ctrl and

4 Not available in the Hardware version of SPARK.
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drag it to another instrument icon to make a copy.

Set Pan
Click and maintain click to set panning.

A small window appears next to the knob to let you know the amount and
direction of pan applied. Click right to edit or disable pan motion.

Set volume
Click and maintain click to set volume.

A small window appears next to the knob to let you know the amount and
direction of volume applied. Click right to edit or disable volume motion.

Mute an instrument

The Mute button on the center panel will flash to indicate that a Mute has
been set from another panel (studio, mixer or sequencer).

Set solo on an instrument

The solo button on the center panel will flash to indicate that a solo has
been set from another panel (studio, mixer or sequencer).

Edit mode button

Click on the Edit mode button to enter the instrument edit Mode.

5.3.1.1 Instrument Edit Window
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10

11

12

13

14

15

16

17

18

19

Change instrument type. You may also drag and drop
an audio file here (and also directly onto an
instrument pad).

When dragging and dropping onto pads: if the current
instrument is sample based it will replace the previous
sample with the new one. If the current instrument is not
sample based, a menu will appear asking if youd like to
change the instrument type.

Rename instrument.

Turn Mute on (M) / Turn solo on (S).
Set pan.

Set volume.

Change filter type on instrument.
Cutoff filter knob.

Resonance filter knob.

Sample layer display for each layer - Numbered 1 to
6

(For Sample type instruments only)
Load new sample.

Set reverse mode on sample.
Unload a sample.

Layer display window. Drag and drop audio file here
to change the layer’s sample.

Layer tool.
Gain knob for sample.
Change Center panel knob assignment.

Change value for parameter 1 (out of 6 total) of
edited instrument.

Play edited instrument.

Link button: links layers together so that gain,
reverse, start and end points are the same on all
layers. To edit these parameters individually on each
layer, Link should be off.
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5.3.1.2 Studio Buttons

1. Display Instruments 1 to 8
2. Display Instruments 9 to 16
3. Display all instruments / Hide Instrument view

Click on the 1-8 button to display the first eight Instruments.

If you want to see all of your instruments displayed at once, click on "All".
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5.3.2 The Mixer®

Click on "Mixer" to display the Mixer panel

B Ty AN

AUX1| AUX1
AUX2

n

PAN PAN PAN PAN PAN A A A A A PAN PAN PAN

N ETE Lo

This panel is your 16 channel mixer panel. This is where all your instruments will be

mixed together. Here, the modified signals will be summed to produce the combined
output signals.

Each track is numbered from 1 to 16 at the top of the window. To the right of the mixer
window are Returnl — Return 2 and finally the Master track.

Let's take a close look at the Mixer.

5.3.2.1 The Instrument tracks

6 Not available in the Hardware version of SPARK.
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1 Assign an output for instrument 1 (available when Spark
is inserted into a host sequencer with Multi-output Mode.
See chapter 6.2 Plug-in mode for more details).

2 Set Aux1 amount for instrument/Channel 1
3 Set Aux1 amount for instrument/Channel 1
4 Set Pan for instrument/Channel 1

5 Open FX1 window for instrument/Channel 1
6 Open FX2 window for instrument/Channel 1
7 Set Solo/Mute for instrument/Channel 1

8 Change volume for instrument/Channel 1

9 Instrument name

To select a track click on the bottom of the track, on the instrument's name.

5.3.2.2 The Return 1 and 2 tracks

®

1 Open AUX FX window

2 Set volume for AUX return
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5.3.2.3 The Master track

1 Open Master insert 1 FX window
2 Open Master insert 2 FX window
3 Set Master volume

5.3.2.4 The Effects

When you click on one of the Aux FX buttons, a scroll up window will appear: this is the
AUX FX window.

EFFECTS

To select an effect, click on [SELECT EFFECT].
Choose one from the list, for example Compressor. The compressor window appears.

You can now set the parameters for the Compressor FX.

FX parameters
0
O ©
&) EFFECTS
9 &l COMPRESSOR

(“ THRESHOLD RATIO (‘ )

INPUTGAIN MAKEUP

%

-’ -
ATTACK RELEASE
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1 Bypass all effects

2 Close FX window

3 Bypass FX1/FX2 for one instrument /channel-Aux-Master insert
4 Change/Remove FX (Inst./Channel, Aux or Master insert)

5 Load a factory FX preset

6 Set Dry/Wet mix (Inst./Channel, Aux or Master insert)

Compressor parameters

6

A compressor evens out differences in gain by reducing dynamics (difference in volume
between quiet sounds and loud sounds). This effect is often used to ‘fatten’ a sound by
making every individual element of the sound closer to the same volume. Every time a
sound goes over a certain volume (Threshold), it is reduced by a specified amount
(Ratio). Attack and Release determine how quickly the reduction is added and how

®
Change Input gain
Change Threshold
Change Attack
Change Ratio
Change Release

Change Makeup

®

quickly it disappears. Makeup boosts the compressed signal’s level.

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’S MANUAL



Bit Crusher parameters

@ BIT CRUSHER

(« (®

BIT DEPTH DOWNSAMPLE

1 Change Bit depth

2 Change Downsample

A bit crusher reduces the bit depth and sample rate of the audio signal. The result is a

very digital sounding

distortion.

Chorus parameters

7

@ cHoRus TEMPO SYNC

B simus «

RATE FEEDBACK

NOISE
SHAPE

Change Shape

Set Tempo sync on/off
Change Rate

Change Depth

Change Feedback
Change Spread

Change Delay

Chorus is a classic effect that uses small delay times (that are modulated by an LFO) to
double a sound, making it seem fatter and thicker. Shape, rate and depth refer to the
LFO. Delay is the delay time and feedback is the amount of delayed signal added back to
the dry signal. Both of these parameters emphasize the effect when increased. Spread

refers to the width of

the sound in the stereo field.
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Delay parameters

@ EFFECTS

@ pELAY TEMPO SYNC

@ unK  TIME FEEDBACK
™ F™

1 Delay output (Link/Unlink).
Apply (Disable) same values for right and left

2 Set time for left and/or right channel
3 Set Feedback for left/right channel

4 Set ping-pong mode on/off (Can be turned on only if "Link" is

off.)
5 Set Damping value
6 Set tempo sync on/off

A delay repeats a sound, giving it more space and depth. Linking channels applies the
left channel’s delay time and feedback to the right channel. For separate parameters on
both channels Link should be deactivated. Ping Pong alternates the delayed signal
between the left and right channel (for an increased stereo effect), and dampening
reduces high frequencies by adding a Lowpass filter to the feedback chain.

Distortion parameters

@ pisTORTION

. CRUNCH 1
CRUNCH 2
TUBE ouTPUT

1 Change Distortion type
2 Change Drive amount

3 Change Output gain
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A distortion saturates and distorts a sound by increasing the volume of a signal then
clipping the excess. This effect can add strength, high-end and be volume to a sound.

Parametric EQ parameters

@ "ARAMETRIC EC

©

FREQ

GAIN GAIN

1 Change Low gain

2 Change Low frequency

3 Change Middle frequency

4 Change Middle gain

5 Change Middle band frequency width
6 Change High frequency

7 Change High gain

Parametric EQ allows one to boost or reduce the volume of frequency bands. FREQ
selects the frequency and GAIN allows one to remove or add volume to that band. Width
(MID only) determines the width of the middle band around the specified FREQ.

Phaser parameters

@ PHASER TEMPO SYNC

RATE FEEDBACK DEPTH RATE FEEDBACK DEPTH

sine [l woise sine [l noise
SHAPE DUAL MODE SHAPE

1 Change Tempo sync on/off

2 Change Rate on stage 1 and/or stage 2
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Change Feedback on stage 1 and/or stage 2

Change Depth on stage 1 and/or stage 2

Change Shape on stage 1 and/or stage 2

6

Set Dual mode on/off

A phaser is similar to a chorus effect, in that it uses small delay times to affect a signal,
the result is a sweeping comb-filter sound.

Plate Reverb parameters

e v e

PRE-DELAY STEREO DAMPING

Change Reverb size

Change Pre-delay size

Change Stereo value

Change Reverb filter damping

Change Low cut frequency filter

6

Change High cut frequency filter

A reverb emulates the reflections of a sound in a different space (room, hall, etc).
Reverb adds depth and richness to a sound by ‘placing’ it in a separate physical space.
The size knob changes the size of the space. Predelay adds a small amount of delay to
the sound to imitate early reflections. Stereo refers to the width of the stereo field of the
reverb. Dampening sets how much the reverb should be filtered using the Lo and Hi Cut

filter settings.
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Reverb parameters

@ REVERB
(3 HF DAMPING DIFFUSION FEEDBACK
GAIN @ € )
( &

BRIGKTNESS DECAY TIME

\E
D

1 Change gain

2 Change High frequency damping
3 Change Brightness

4 Change Diffusion

5 Change Decay time

6 Change Pre-delay Feedback

7 Change Pre-delay Time

A reverb emulates the reflections of a sound in a different space (room, hall,
etc). The material section (HF Dampening and brightness) sets the timber for
the reverb (dark or bright sounding). The shape section (Diffusion and Decay
time) sets the size and duration of the reverb. The pre-delay section (Feedback
and Delay) adds a small delay to the reverb to emulate early reflections.

5.3.3 The Library
Click on "Library" to display the Library panel.

The library is divided into 2 main windows: the library window and the current project
window.
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5.3.3.1 The Library Window

ct: Funk Drums

prod.com

A)—F |
H PROJECT BANK PATTERN INSTRUMENTS
y & Factory

® & User u . A ‘ Funk Drums Kit | Physical / Sample

on wdoeawwb It U s
o, I . EER '- fAseoceoeeca
9 \ﬁ 9 ) 1| SAMPLE | BD | Funk Drums_BD
m ﬁmio =
©® ®

1 Display Factory project only (Click to select)

2 Display User project only (Click to select)

3 Import a project to the Library

4 Make a new project

5 Delete a project from the Library

(Only user projects can be deleted)

6 Display Kit/Instruments information for one project in Library. Double click
on kit to Load it.

7 Load a Bank (A,B,C or D) from the Library to the corresponding one in the
Current project

8 Load a Pattern (1 to 16) from the Library to the corresponding pattern in
the Current project

9 Load a kit from the Library to the current project

10 Load an instrument from the Library to the corresponding selected
instrument in the Current project

11 Enter "Edit current project" mode

12 Select a project in the coverflow.
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5.3.3.2 The Current Project window

&d—-‘,‘,&.

B-. - e @ e o

1 Import a MIDI file or a REX file in current pattern

2 Export current project as .ads file (SPARK) or export current
pattern as MIDI or AUDIO file

3 Save current project
4 Save current project to new project

5 Exit current project edit mode (takes you back to the
“Coverflow” dynamic Project menu).

6 Change image for current project

7 Change the style of the current project
8 Change author name

9 Bank list of the current project

10 | Pattern list of the current project

11 | Loaded instruments of the current project

5.3.3.3 Creating a new project

To create a new project, click on the "New Project" button in the library window. Give a
name to your new project. It will appear in the project list as the current project. You
can now edit your new project.
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5.3.3.4 How to load Kits and Instruments

To load a Factory or user project in your current project, double click on an instrument
kit in the Library/Project window. This will load the entire kit to your current project.

To load one or several instruments from a kit, go to the Library/Instruments window.

Double click on an instrument to load it to your project. When double clicking on an
instrument, it is placed in the selected instrument slot in the Loaded Instruments window
in the current project window. To select a slot, click on the instrument number in the
Loaded Instruments window.

An easier way is to "Drag and Drop" an instrument from the “Instruments" window to
any slot in the Loaded Instruments window.

You do not need to select an instrument slot when doing it this way.

5.3.3.5 How to load Banks and Patterns

In the same way, you can load a bank or a pattern from the library to the same bank or
same pattern number in your current project by double clicking on it.

If you want to load Bank A from the Library to Bank D of your current project, drag and
drop Bank A on to Bank D.

To load pattern Al to pattern C3 of your current project, simply drag and drop Al to C3.
Pattern C3 will light up to confirm your selection.

5.3.3.6 Importing and Exporting a project

To import a project click on the "Import" button in the current project window. A menu
lets you choose between MIDI file and REX file formats.

To export a project click on the "Export" button in the current project window. A menu
lets you choose between:

*  Exporting as a SPARK project (.spk)
*  Exporting selected pattern as a MIDI file (.mid)
*  Exporting selected pattern as an AUDIO file (.wav)

It is also possible to export a bank or pattern as a MIDI or WAV file (option to be set in
the Preferences Panel) by simply dragging and dropping. To do this click on the bank or
pattern you wish to export. Hold your click and drag the element to the place of your
choice on your computer (desktop or host sequencer for example). If you dragged a
Pattern, a single MIDI or WAV file will appear. If you dragged a bank, 16 separate
MIDI/WAV files (corresponding to the 16 patterns of the Bank) will be created. In case of
an Audio export you need to hold your click until rendering is completed, otherwise your
render will be cancelled. Alternatively you can right-click on the pattern and select
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render option. A *(star) will be added at the end of pattern name to show that the
pattern has been rendered. Ex: Al*.

You can personalize the cover image of your project:

Click on "Change image" next to the current cover image. Choose a picture in your own
picture library and click on “"Open” to replace it.

5.3.3.7 Saving a project

To save your project, click on the "Save as" button.

A drop down menu will appear. Chose "Save as..." in the current project window. Give a
name to your project and choose a style from the drop down menu. Click "OK". Your
project is now saved.

If you make changes to a project you already saved just click on the button "Save".

5.4 THE TOP PANEL

5.4.1 Overview

The top panel features the Pattern panel and the Song panel as well as SPARK
preferences menu.

When you click on the "TOP" button in the toolbar the pattern window opens by default.

At the bottom of the panel you will find the Pattern Panel button, the Song panel button
as well as the Preferences button.

5.4.2 The Pattern Panel

Arturic_z

The Pattern panel features SPARK's sequencer. It is both a composing tool as well as a
powerful editing tool.
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5.4.3 The Toolbar

1 Change upper part

2 Change lower part

3 Change step resolution
4 Change number of bars
5 Change number of steps

6 Click to display patterns 1 to 16

The time signature is a notational convention used in musical notation to specify how
many beats are in each measure and which note value constitutes one beat.

Time signatures consist of two numerals, one stacked above the other: the lower
numeral indicates the note value that represents one beat (the "beat unit").

The upper numeral indicates how many such beats there are in a bar.

For instance, 4/4 means four quarter-note (quarter note) beats; 3/8 means three
eighth-note (quaver) beats, etc.

1. Click to change the upper part of the time signature of the current pattern. This
defines the number of notes (units) in one bar: Setting the signature to 4/4 means that
there 4 quarter notes in a bar, if signature is 3/4 (waltz) it means there are 3 quarter
notes in a bar.

2. Click to change the lower part of the time signature of the current pattern. This
defines the note value (unit): 1=whole - 2=half note - 4=quarter note - 8=eighth note.

3. Click to change the Step resolution. The step resolution is the value of one step:
1/16=sixteenth note - 1/8=eighth note - 1/4=a quarter note, etc. A pattern has from 1
to a maximum of 64 steps.

4, Click to change the number of bars in the current pattern.

5. Click to change the total number of steps in the current pattern. The number of
steps is automatically calculated by Spark using the step resolution, the number of bars
in the pattern, and the time signature. But you can adjust it if you want to work with
your own bar calculation.

6. Click to display Step 1 to 16 in the current pattern.
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5.4.4 The Sequencer

‘A'rturio

1) @ ®

The Pattern panel shows 8 instrument tracks out of the 16 available. To see the next 8
tracks, use the scroll bar.

The picture above shows the pattern panel with a time signature of 4/4, hence 1 bar of 4
quarter notes (each quarter note subdivided into 4 1/16 note steps)- which adds up to
16 1/16 note steps.

1 Click to display the Pattern panel

2 Click to display the Song panel

3 Click to display the preferences panel

4 Set Step on/off on one track in the current pattern

5 Select a track in the current pattern. (Hover above the track until it
lights up, then click).

6 Set Solo on/off on one sequencer track in the current pattern. (The
solo button in the center panel will flash to indicate that a solo has
been set from another panel (studio, mixer or sequencer)).

7 Set Mute on/off on one sequencer track in the current pattern. (The
Mute button in the center panel will flash to indicate that a mute has
been set from another panel (studio, mixer or sequencer)).

8 Click to open or close the Automation editor for one track in the
current pattern.

5.4.4.1 How to select a track

To select a track, move your cursor over the track. When the track lights up, click to
select.
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5.4.4.2 How to copy or swap tracks

To copy a track, move your cursor over the track. When the track lights up, click
[Option/alt] on Mac / [Ctrl] on Windows, then click and drag the track onto another one.

To swap tracks, just drag a track onto another one.

5.4.4.3 How to copy or swap Step parts

To copy step parts click on a step part button while holding [Option/Alt] on Mac / [Ctrl]
on Windows and drag it onto another one.

To swap step parts, click on a step part and drag it onto another one.

5.4.5 The Automation editor

1 Click to display the automation value of a single parameter in the current
pattern.

2 Pen tool - Line tool - Eraser tool

3 Click and drag to draw automation on a single parameter using the pen or

line tool or erase drawing. Except for velocity, repeat and shift parameters,
you can use up to 4 sub-values per single step. Use Cmd on mac and Ctrl on
windows to erase or move the four automation sub-values of a single step
note together

4 Disable/Enable all automations in the current pattern.

5 Disable/Enable one single automation in the current pattern.

6 Click to trigger drop down menu of parameters on to which automations may
be applied.
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5.4.6 The Song Panel
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The song panel allows you to chain all your patterns to create a Song.

As we have seen before, a song is an editable ordered sequence of several patterns that
defines the structure of your song.

SPARK allows songs made of 64 patterns maximum.

The Song panel will allow you to organize your patterns in sequences to make your song.

1 Click and drag a pattern from one bank into a song slot.
2 Select song slot and click "copy" button [C] to copy into SPARK clipboard.
3 Click on destination slot then click on paste [P]. If you have copied 3 slots,

the 3 slots located at your paste location will be replaced.

4 If bars are copied into clipboard, click on a slot where you want to insert
selection and click [Insert]

5 Once slots are selected you can click on [Delete] to delete them. This will
shift back all the slots that were located after the last deleted bar.

6 Song slots are numbered from 1 to 64. Click to select.

5.4.7 The Song slots

The Song plays chained patterns from the first one to the 64,

The song is organized in 64 slots; each slot can receive a pattern. But your song can be
any number of patterns with a maximum of 64.

5.4.7.1 How to copy patterns to song slots.

To copy a pattern to a song slot, click on a pattern in the pattern wheel and drag it to a
song slot.
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5.4.7.2 How to move and paste/insert slots
You can select a slot or a group of slots and paste or insert them in another location.

To do so, once the slot (or group of slots) has been selected, drag the selection and drop
it onto another slot: If your mouse pointer is on the first half of a bar this will insert the
dragged pattern at the location. If your mouse pointer is in the last half of a bar, it
will be pasted and will replace bars at location

5.4.7.3 How to set song playing position

Double click on a slot to set the song playing position.

5.4.7.4 How to select several slots

To select several song slots, just click on a slot and drag your cursor over the
neighboring slots.

5.4.8 Preferences Button

SEQUENCER

Switch pattern instantanately

Follow current step

Quantize Record

Auto-Start Song No

Click Output Master

Next Bank/Pattern switch mode Click on Bank switches immediatly

Automation loop free No

FILE

Save a copy of audio samples in library Always

Library Path William: /Library/Arturia/Spark/Spark Library
MIDI IMPORT/EXPORT
Pattern Drag&Drop Export mode in Library Export to Wav File

Wav exoort size One Pattern Lenath

Cree P ]

The preferences are divided into:
e Sequencer
* File
¢ MIDI Import/Export

5.4.8.1 Sequencer preferences

Switch pattern instantaneously: If set to "Yes", a new pattern will play instantaneously
when it is selected. If set to "No", it will be played when the current pattern is finished

playing.

Follow current step: When set to "Yes", and when on Sequencer panel, the step pads on
the center panel will automatically display the step part that contains the current played
step.

Quantize record: When set to "Yes", all pads playing as well as any recordings will be
quantized.

Auto-start song: When on, clicking on the Song button in the center panel will open the
song panel and start playing the song automatically.
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Click Output: Selects output for metronome click.

Next Bank/Pattern switch mode: When set to immediately, clicking a different bank will
directly play the same pattern number in the new bank. Otherwise, one must first select
the new bank, then specify the pattern of this new bank, even if it's the same pattern
number as the currently played pattern.

Automation Loop free: When on, the loop will be applied only on notes in the pattern,
not on automations.

5.4.8.2 File preferences

Save a copy of Audio samples in Library: When importing .wav/.aiff files to Spark, the
source file will be copied in the library. You have the choice between:

* Always: always copy files in the library
* Ask: ask the user
* Never: never copy files in the library

Library path: Changes the path to SPARK's library.

5.4.8.3 MIDI Import/Export preferences:

Pattern Drag&Drop export mode in library: When dragging a pattern in the library panel,
the pattern will be exported as MIDI file or bounced to .wav file.

Wave export size: When saving a pattern as a .wav file, you can choose between
exporting the pattern in its initial size, or doubling the size of the pattern. Doubling the
size will avoid losing an effect playing beyond the end of the pattern (i.e. a reverb or a
delay).

Choose Drum map model for MIDI pattern import: When importing a MIDI pattern, you
have the choice to import it as a SPARK, General MIDI or ADDICTIVE Drum map.

Choose MIDI map model for Pads: You can choose an existing mapping for the pads
being controlled by an external midi controller. Spark Option is the mapping used by
Spark controller, General Midi is a standard midi mapping, and you can define your own
mapping using “Custom” Option and assigning midi notes on pads using Cmd-Click on
OSX or Ctrl on Windows on pads.

“Enable default Pad velocity” preference is used to trigger pads with a constant velocity
defined with the “Default Pad Velocity” preference. Hit intensity is ignored when this
preference is set to “Yes”.

5.4.8.4 Controller Preferences

Knobs speed sets the reactivity of the knobs in Spark, and can vary between slow,
normal and fast.
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6 MODES OF OPERATIONS

6.1 STANDALONE (OVERVIEW)

6.1.1 Launching the standalone application

To launch the standalone application:

¢ On Windows: Start menu > Programs > Arturia > Spark... and choose
Spark.

¢ On Mac OS X: Finder > Applications > Arturia > Spark... and double-click
on the Spark application icon.

6.1.2 Preferences configuration - Audio & MIDI settings

6.1.2.1 Windows

To access the preferences window click on the SPARK menu > Setup > Audio & MIDI
Settings. This window allows you to configure the global preferences of SPARK. These
are saved automatically.

Audio & MIDI Settings

Built-in Output

Show advanced settings...

6.1.2.2 Mac OS X

To access the preferences window click on the SPARK menu > Preferences. The Audio
settings window will appear. This window allows you to set the global preferences of
SPARK. These are saved automatically.
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"% Spark |
™ ¢ About Spark

Preferences... 8,

Update Spark Controller

|

L
Services [ 2

5
Hide Spark ¥H mm
Hide Others X#¥H

TAI
Quit Spark #¥Q !

(Windows) Selects the appropriate driver for your audio device.
AUDIO DEVICE TYPE

(Mac_0s) OUTPUT Chooses which audio output SPARK will send sound out of.
) Default is “Built-in Output” on the Mac; for Windows we highly
(Windows) DEVICE suggest to use an adequate ASIO driver for your sound card.

TEST Send out a short sine wave tone to help make sure sound is
being sent out the correct device.

SAMPLE RATE Choose the sample rate; default is 44,100 Hz. Increasing the
sample rate increases the quality of sound, but adds a bigger
load to CPU.

AUDIO BUFFER SIZE | Chooses the audio buffer size, displayed in samples and
milliseconds. Default is 512 samples. Decreasing this number
lowers latency, but adds more load to CPU. Increasing lessens
load on CPU but augments latency (latency is the delay between
a note played and actual sound output).

ACTIVE MIDI | Displays the available MIDI inputs that can be used to control
INPUTS SPARK.

6.1.3 Update Spark Controller

To access the Update Spark Controller Menu Item, click on SPARK menu >
Update Spark Controller.

When you update Spark Software, your controller firmware may need to be
updated as well. Spark will warn you when starting with Spark controller
connected. Use this command to update your controller when Spark warns you.

6.1.3.1 Windows

To access the preferences window click on the SPARK menu > Setup > Audio & MIDI
Settings. This window allows you to configure the global preferences of SPARK. These
are saved automatically.
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6.1.3.2 Mac OS X

Audio & MIDI Settings

Built-in Output

Show advanced settings...

To access the preferences window click on the SPARK menu > Preferences. The Audio
settings window will appear. This window allows you to set the global preferences of
SPARK. These are saved automatically.

(Windows)
AUDIO DEVICE TYPE

(Mac_0S) OUTPUT
(Windows) DEVICE

TEST

SAMPLE RATE

AUDIO BUFFER SIZE

|
About Spark i I

Preferences...
Services >

Hide Spark #H
Hide Others " 3H

Quit Spark #¥Q

Selects the appropriate driver for your audio device.

Chooses which audio output SPARK will send sound out of.
Default is “Built-in Output” on the Mac; for Windows we highly
suggest to use an adequate ASIO driver for your sound card.

Send out a short sine wave tone to help make sure sound is
being sent out the correct device.

Choose the sample rate; default is 44,100 Hz. Increasing the
sample rate increases the quality of sound, but adds a bigger
load to CPU.

Chooses the audio buffer size, displayed in samples and
milliseconds. Default is 512 samples. Decreasing this number
lowers latency, but adds more load to CPU. Increasing lessens
load on CPU but augments latency (latency is the delay between
a note played and actual sound output).

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 71



ACTIVE MIDI | Displays the available MIDI inputs that can be used to control
INPUTS SPARK.

6.2 PLUG-IN MODE

For specific use in VST, Audio Unit and RTAS please refer to 6.3, 6.4 and 6.5 sections.

In order for Spark controller to work correctly with Spark used in plug-in mode, it is
necessary to turn off some MIDI connections in your sequencer software. Go to your
sequencer's MIDI settings and turn off 'Spark Private In' and 'Spark Private Out'. Without
this configuration:

- Spark controller will not connect to Spark on Windows.

- Spark controller will not behave correctly on OSX.

You can use Spark as plugin in stereo or Multi Output Mode. The host will show one
stereo output from Spark when used in Stereo Mode. When used in Multi output mode
the host will show 16 stereo channels available. You can modify the track output routing
in Spark in the mixer panel. Default routing sends all tracks to the master stereo output,
the first output. You can assign a track output to another stereo output of the 16
available outputs. See Chapter 5.3.2.1

6.2.1 Toolbar Extra Buttons

When using SPARK in Plug-in mode, the toolbar features 2 additional buttons:

1. Host button

When on, the current Spark pattern will start and stop along with the Host
sequencer transport.

2. Tempo button

When on, the current Spark tempo will be set to the host tempo.

6.2.2 Saving project

When the project is saved, SPARK is saved in its last mode of operation, with all
modifications intact. For instance, if you are working on a project in which you have
modified parameters (without saving this as a separate preset in the plug-in itself), the
next time you open the project SPARK will load the project and the modifications as well.

The drop-down menu with the VST sequencer, allowing you to save a new project, is of
course usable with SPARK. However, it is highly advised to use the SPARK’s internal
menu: the presets saved in this way are usable in any other mode (standalone or with
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another sequencer), and can be exported and exchanged more easily, as well as remain
compatible with future SPARK versions.

6.3 VST

6.3.1 Installation

6.3.1.1 Windows

During installation, select the box “VST” among the proposed format choices of plug-ins.
The installer will automatically detect the VST folder of the instruments shared by
Cubase or any another compatible VST sequencer.

6.3.1.2 Mac OS X

The VST plug-in is automatically installed in the folder of the system corresponding to
the VST instruments: /Library/Audio/Plug-Ins/VST/

The VST plug-in will be usable by all your VST host applications.

6.3.2 Instrument use in VST mode

The opening of VST SPARK plug-ins is the same as opening all other VST plug-ins. Please
consult the instruction manual of your favorite host sequencer for more specific
information.

For instance, under Cubase, open the menu “VST Instruments”, and choose Spark in the
rack.

M O VST Instruments

~
¥ No VST Instrument l

Analog Factory
Steinberg » ARP2600 V2

Brass 2

Cs-80v2

CS-80V2 (10 voices)
Jupiter-8v2
minimoog V

Moog Modular V 2
Prophet-V2

6.3.3 Connection to an instrument track

In order for SPARK to play information coming from an Instrument track, you have to
choose an Instrument track and select Spark as the output of this track. See the picture
below for more detail on how this is accomplished.
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7 O  Add Instrument Track

Instrument Track Configuration

No VST Instrument

UL v No VST Instrument

@ Browse Pre!

Steinberg > ARP2600 V2

T T E—— Brass 2

CS-80Vv2

CS-80V2 (10 voices)

Jupiter-8v2
minimoog V
Moog Modular V 2
Prophet-V2

The events played on a MIDI keyboard are recorded by your host sequencer, and you

can now use the MIDI editing possibilities of the sequencer to control any

in SPARK.

6.3.4 Multi Output Mode

parameter

Create an instrument using the VST Instrument Menu then click on Spark; then select
the output you want to enable by clicking on the button just on the left of the instrument

name in this menu.

® O VST Instruments
I 0 E G| Spark
: Activate All Outputs

-1 [Stereo]
1 [Stereo]
3 [Stereo]
S [Stereo]
7 [Stereo]
9 [Stereo]
11 [Stereo]
13 [Stereo]
15 [Stereo]
17 [Stereo]
19 [Stereo]
21 [Stereo]
23 [Stereo]
25 [Stereo]
27 [Stereo]
29 [Stereo]
31 [Stereo]

6.4 AUDIO UNIT (MAC OS X ONLY)

6.4.1 Installation

The Audio Unit plug-in is automatically installed and by default in the following folder:
/Library/Audio/Plug-Ins/Components/
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6.4.2 Use in Logic Pro

From version 7 and on, Logic Pro features an Audio Unit plug-in manager. To launch the
Audio Unit plug-in manager, click on the menu Preferences > Audio Units Manager.

2 LUeCl File Edit Options Window Screenset1 Help l
® 61 About Logic Pro .
i Preferences > General...
R . = Audio...
v Provide Logic Pro Feedback MIDL...
B Services > Display...
Score...
Hide Logic Pro #H Video...
U Hide Others X &H Automation...
Show A Sharing...

Quit Logic Pro Initialize All Except Key Commands...
Audio Units Manager...

Chord Grid Library...

» Advanced Quantization

| b Big Beat Remix Kit Control Surfaces

Key Commands...

This Manager will show you the list of available plug-ins, test their compatibility with
Logic, and then allow you to activate or de-activate them.

If an Arturia plug-in poses problem in Logic, start by checking that this plug-in has
passed the compatibility test, and that it is actually selected.

6.4.2.1 Stereo Mode

Select an Instrument track. On the mixer portion of the corresponding track, click on the
button “I/0” to obtain the list of plug-ins, then select AU Instruments > Arturia > Spark
> Stereo.

[seting ]
£Q E
Inserts

Inserts

EFML (FM Synth)

ES E (Ensemble Synth)

ES M (Monophonic Synth)
ES P (Polyphonic Synth)
ES1 (Synthesizer 1)

ES2 (Synthesizer 2)

EVE3 (Tonewheel Organ)
EVD6 (Electric Clav)

EVOC 20 PS (Vocoder Synth)
EVPSS (Electric Piano)
EXS24 (Samplen)

External Instrument
Klopfgeist

Sculpture (Modeling Synth)
Test Oscillator

Ultrabeat (Drum Synth)

Analog Factory
ARP2600 V2
Brass 2
Cs-sov2
Jupiter-8v2
minimoog V

| Moog Modular V 2
Prophet-V2

GarageBand Instruments

AU Generators
AU Instruments

Ly ¥ vyYyvYyvYyvYyYTYTYYYYYYYYY

dvyvvvvvvyyw

6.4.2.2 Multi Output Mode
To use the separate outputs:

Select an Instrument track. On the portion of the mixer corresponding to the selected
track, click on the button “I/O” to obtain the list of plug-ins, then select AU Instruments
> Arturia > Spark > Multi Output (16xStereo).
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Then go to the mixer view and click on the

v No Plug-in

EFM1 (FM Synth)

ESE (Ensemble Synth)

ES M (Monophonic Synth)
ES P (Polyphonic Synth)
ES1 (Synthesizer 1)

ES2 (Synthesizer 2)

EVE3 (Tonewheel Organ)
EVDE (Electric Clav)

EVOC 20 PS (Vocoder Synth)
EVP88 (Electric Piano)
EXS24 (Samplen)

External Instrument
Klopfgeist

Sculpture (Modeling Synth)
Test Oscillator

Ultrabeat (Drum Synth)

GarageBand Instruments.

AU Generators
AU Instruments

track to add Aux tracks.

Y ¥ YYYYVYVYYYYYVYVYYYVYY

£Q H £Q
Inserts Inserts

|
1o 1o

' Spark 3-4 | | Spark 5-6 |
|Stereo Out | | Stereo Out

Aux 1 Aux 2

[

[™I(s]

lMIlSI

1)

Stereo Out

[ | —
—Hﬁi—l

|

(ml(s]

f_]lTnc_e]

Multi Output (16xStereo)

“+” button at the bottom of the

instrument

You can choose the output number of each instrument in Spark in the Mixer View. (see

chapter 5.3.2.1.

6.4.3 Use in Digital Performer

6.4.3.1 Stereo Mode

To add an instrument, choose the menu Project > Add Track > Instrument Track >
Arturia > Spark (stereo)
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& Digital Performer _File Edit_Region _Audio m Studio _Setup _Window _Help 3
] dd Trad MIDI Track oxv 2l
[" — "“ LIS h Alp ol Mono Audio Track ORA ﬁ&) MOTU
7 . 3 ! Stereo Audio Track oxs E=
STEIET Rl EF N C EY L Surround g™ ™
»

') Modify Conductor Track
- | IR 'nsert Settings > B =
h — o T T ) Track Folders _ ¥ Add Instruments. Xoxi Aople: DLSMusicDevice (stereo) [ Seatt> @ §
Track Groups XOC  add Unassigned Instrument  OXI  Arturia: CS-80V2 (sterec)
e Modify Track Groups > MOTU: BassLine (stereo)
: ~ (o Aux Track ARA " s
- N . . MOTU: Model 12 (stereo)
i 4 |3 |t Sequences - ~ Bom @ o (n 2o |
[ e v )11 | I psore oc | Master Fader Track (b M | LOTU: Modulo (stereo) ol il o O ol ol
- Tracks oT T T MOTU: nanosampler (stereo)
I Sequence Edior 0s MOTU: PolySynth (stereo)
MOTU: Proton (stereo)
Mixing Board oM a Analog Laboratory (stereo)
Effects OF N ARP2600 V2 (stereo)
Markers oK Jupiter-8V2 (stereo)
Lyrics AN ONL minimoog V (sterec)
. Moog Modular V 2 (stereo)
Graphic Editor oG Prophet-V2 (stereo)
3 park (stereo)
Drum Editor 0D
QuickScribe Editor 0Q
3
i Soundbites 0B
[ Clippings »
i Consoles -
i Movie ov

Once you have added this instrument, it's possible to assign a MIDI track to it. In the
connection menu of the MIDI track, select the instrument and the MIDI channel that you
want to use. Make sure you activate the track before starting to play or record.

6.4.3.2 Multi Ouput Mode

To use the separate outputs, create the number of new Audio tracks you want, and then
choose the correct OUT of the Spark plugin.

—

o SPARK AUDIO SAMPLE 1

| |

M Tecks [ Sequence LT . e | MixingBoars | Song | SoundFie | MeterBrige il

c ) miniemoog V-1 > (8) = 1000 [+ 31111000 [+ 120000 [+|(a)k
Seq't Q[E™FYTEN  Seark- b Sparkl1
o 2 5 6 7 1] 0 10 " ) 9 1
i £00R LOGK RS MOW T KevE puke e 00 > San-1-2 —J A K A A A A & e il &
g > AC Driver > Spark-1-3
> - v Unconfigured Ports B Spark-1-4 |
- & Spark-1-5
New Device Crown... Spark-1-6
Spark-1-7
Spark-1-8
Spark-1-9
Spark-1-10
Spark-1-11
Spark-1-12
Spark-1-1
S 14
Sp 1
So. 1
—

6.4.3.3 Assign Midi Track

Once you have added this instrument, it's possible to assign a MIDI track to it. In the
connection menu of the MIDI track, select the instrument and the MIDI channel that you
want to use. Make sure you activate the track before starting to play or record.

6.4.4 Stereo Mode and Multi Output Mode

6.4.4.1 Stereo Mode

To add an instrument, choose the menu Project > Add Track > Instrument Track >
Arturia > SPARK.

Once you have added this instrument, it's possible to assign a MIDI track to it. In the
connection menu of the MIDI track, select the instrument and the MIDI channel that you
want to use. Make sure you activate the track before starting to play or record.

6.4.4.2 Multi Output Mode

To use separate outputs: select an Instrument track. Then on the portion of the mixer
corresponding to the selected track, click on the button “I/O” to obtain the list of plug-
ins, then select AU Instruments > Arturia > SPARK > Multi Output (16xStereo).
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6.5 PRO TOOLS

6.5.1 Installation

In Mac OS X, the plug-in is directly installed in the folder reserved for the ProTools plug-
ins in:

/Library/Application Support/Digidesign/Plug-Ins

In Windows, at the time of the installation procedure, select the RTAS plug-in among the
proposed choices of plug-ins. Then, when the system asks, indicate the folder in which
the other RTAS plug-ins are located.

Usually, this path is:
C:\Program Files\CommonFiles\Digidesign\DAE\Plug-Ins\

6.5.2 Utilization and opening of the Plug-in

Access to the SPARK plug-in is like all other plug-ins; simply create a stereo Instrument
track:

® ProTools LE File Edit View Jcl<4l Region Event dioSui Options  Setup Window Help
000 o Edit: Analog Laboratory

1111000~ &

Langth

COMMENTS INSTRUMENT

In order for SPARK to play the information coming from the Instrument track, you have
to associate it to an Insert channel via the appropriate menu.

More information on plug-in connections can be found in the Pro Tools User’s Manual.

6.5.3 Saving the project

When the session is saved, the status of SPARK is saved as it is, even if its programming
does not correspond to the preset. For example, you are working on a project in which
you have modified the parameters (without saving them in the plug-in itself), the next
time you open the session SPARK will load the project plus the modifications.

The Librarian Menu of Pro Tools can be used with SPARK as with any other plug-in.
Nevertheless, it is highly recommended to use the internal SPARK menu: with the
presets saved this way, they are usable no matter which mode is used (standalone or
other sequencer), and they can be exported and exchanged more easily. They will stay
compatible with the future versions of SPARK.
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6.5.4 Automations under Pro Tools

The automation in SPARK works as with all RTAS/HTDM plug-ins.

Please refer to the Pro Tools documentation for more details on automation plug-ins.
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7 THE SPARK MIDI CONTROLLER

7.1 FRONT PANEL (OVERVIEW)

The SPARK's Hardware Controller has the same interface as the Main Panel in the
SPARK software version. In this overview, we will focus on the features specific to the
Hardware controller.

'éhllllll
LIATY

SEQUENCIT

Loop

1. Digital Display

2. Sequencer zone

3. Song/Pattern zone

4, Jog dial

5. FX live Pad

6. Instrument control zone

7.1.1 Device ports
The Spark controller is listed by a host as being made up of 2 MIDI ports:
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The first one:
- On Windows Vista and 7: "MIDIIN2(Spark Controller)"
- On Windows XP: "Spark Controller [2]"
- On Mac: “Spark Private IN” and “Spark Private OUT”

is used for internal communication between SPARK and the Controller. This MIDI port
SHOULD NEVER BE USED by the user; doing so would impair the efficiency of the
controller.

The second one:
- On Windows Vista, 7 and XP: "Spark Controller"
- On Mac: “Spark Public IN” and “Spark Public OUT”

is the public port to be used by the user.All messages sent to this port will be sent out
the controller's MIDI OUT. All messages sent to the MIDI IN port by a third party
machine will be transmitted to the host on the public port. When using Spark's Hardware
as a MIDI controller, the data flow from the controller will be sent on the USB public port
to the host, as well as on the MIDI OUT port, adding itself to any other existing MIDI
information.

7.1.2 Choose between Kit or Instrument mode

To change from Kit/Project (depending on the option you've selected in the Preferences
Panel of the Spark software) to Instrument mode on SPARK's Hardware controller, press
and hold for 1 second the Jog Dial to change from Kit to Instrument mode.

7.1.3 Set Move Knob Mode

Move Knob is a clickable knob used to switch from “Shift by one step” mode to “Shift by
one loop size mode”.

7.1.4 Set Sequencer Follow Mode On / Off

To set Sequencer Follow mode on or off, press << and >> buttons together.

7.1.5 Roller Fx

When using the Roller effect in the software version of SPARK, the Roll effect can be
applied only to one instrument at a time, for the obvious reason that you are using your
mouse to play the instrument.

When using the Hardware controller, you are free to apply the Roll effect to any number
of instruments, simultaneously. You can also start a roll on one instrument and press
another instrument pad while maintaining your initial Roll. Enjoy!

The Roll velocity is triggered on the software version by clicking on a pad and while
maintaining your click, moving the cursor up and down on the pad. This can be done on
the Hardware controller thanks to its Sensitive pads sending Aftertouch information: the
instrument pad being “pressure sensitive" you can modulate the velocity applied to the
Roll effect in real time.
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7.1.6 Controller Shortcuts

O
>
=
m
—
(Vo)

+

Center Main Panel

Show Pattern Panel

Select

Show Song Panel

Show Preferences Panel

Show Studio Panel

Show Mixer Panel

Show Library Panel

Select

Show Studio Panel
background

N
|
|
|
|
|
B
|
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SEQUENCER

Select

Select

Select

Select

+

=

Display Tempo on screen

Set Metronome on/off

Increase Pattern Length
by one mesure

Decrease Pattern Length
by one mesure

Temporarily increase or
decrease the Tempo
(DJ Mode)

Switch between Quantize
and Unquantize Rec Mode

INSTRUMENTS

=

Select

Select

+

Select

+

Select

Select

Select Instrument

Set Mute Mode on
with no mute Recall

Set Solo Mode on
with no solo Recall

Enter Copy Mode:

-Copy Bank, press A then
B to copy Bank A to B

-Copy Pattern, press A
then 1, press B then 2 to
copy pattern Al to B2

Change instrument
Parameter Knob
assignement

7.1.7 Use as Spark Controller

To use your SPARK hardware controller as a SPARK controller, launch Spark Software
(then press the Connect button on SPARK's toolbar if needed).

Connec; Button
o Jome Joee) ]

If you were in MIDI Controller mode Press the [Filter]+[Slicer]+[Roller] buttons.

80s Studio Drums

7.1.8 Use as MIDI Controller

To use your SPARK Controller as MIDI controller, Press [Filter] + [Slicer] +[Roller] (then
open public MIDI port or connect a MIDI cable to MIDI Out).

7.1.9 Use as USB/MIDI interface

To use your SPARK Controller as USB/MIDI interface, open the public MIDI port in your
host program and connect the MIDI cable(s) to your Spark Hardware controller.
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7.1.10Power Supply
Connect to USB 2.0 host. Avoid using a non-powered USB-Hub. The device is self-
powered by USB.

If you don't need or want to power your Spark Hardware controller via USB, use the DC
jack input with the following power supply unit:

Voltage: 9 Vdc
Current: 800 mA
Polarity: center positive

7.2 REAR PANEL (OVERVIEW)

7.2.1 Rear panel Connectors and power supply

b—essm—g

1. USB connector

2. MIDI IN port

3. MIDI OUT port

4, Power supply

5. Power on/off switch

7.3 SPARK MIDI CONTROLLER SOFTWARE

With the SPARK MIDI controller software you can customize the functions of the Pads,
Knobs and Buttons according to your needs.

When connected, you can use the Hardware controller itself instead of the Controller
software interface to select the buttons, switches or knobs you want to work on.

Spark Midi Controller Software needs Spark Controller to be in Midi Controller mode to
be able to connect to. Press [Filter] + [Slicer] +[Roller] to use Spark as Midi Controller.
If Spark Controller is set to Midi Controller mode before opening Spark Midi Controller
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Software, Spark Midi Controller Software will connect to it automatically at launch. If
Spark Midi Controller Software is started before setting Spark Controller to Midi
Controller Mode, you will need to explicitly connect to Spark controller using Connect to
Spark Controller command in the Action Menu.

7.3.1 Overview

- EIEIE

The SPARK MIDI controller software interface is rigorously the same as the SPARK
Hardware interface or SPARK software main panel.

All the buttons, pads and knobs can be reprogrammed to suit your needs.

7.3.2 The Menu

m Action m

Open... Disconnect to Spark Controller
Save Send to Spark Controller
Save As...

Update Spark Controller

Calibrate Pads
Restore Factory Calib
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1. File > Open...: Open and Load a Template
2. File > Save: Save A Template on the Computer
3. File > Save As...: Save As A Template on the Computer

4. Action > Disconnect to Spark Controller: Disconnect Or
Connect to Spark Controller

5. Action > Send To Spark Controller: Send Template to Spark
Controller

6. Action > Update Spark Controller: Update Spark Controller
Firmware

7. Action > Calibrate Pads: Calibrate the velocity sensitivity of
the Pads

8. Action > Restore Factory Calib: Restore Factory Calibration of
the Pads

7.3.2.1 Midi Templates

Midi Templates: Each control (Pad, Knob or Button) sends a Midi message to the USB
output. Default midi mapping is used for controlling Spark Software. You can customize
this mapping, editing Midi messages sent from any of the controls. New mappings can be
saved as Template Files using the File > Save command. In order for a template to be
active on Spark controller you need to send your template to Spark controller with
'Action > Send to Spark Controller' command. Only one template can be active on Spark
controller at a time.

7.3.2.2 Pads Calibration

You can calibrate the hit intensity at which the maximum velocity will be reached on the
Pads of your Spark controller. Use 'Action>Calibrate Pads' command to start the
calibration process. You will be asked to hit each pad 3 times.

R | mawg
PADS CALIBRATION

’ Hit each pad 3 times with the intensity -
at which you want the maximum

velocity to be reached

Led indicators show you the progress of the calibration:

00e
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You can restore the Factory calibration using Action>Restore Factory Calib" command.

7.3.3 Edit Instrument Pad window

When clicking on a pad, a window appears with several tabs and drop-down menus to
let you change the parameters assigned to pads.

Trig 1 Press 1 Mute 1 Select 1
Name Pad 1 MIDI Channel 1

Message Type Note Mode Toggle

Message Number O - C-2 Action On Release

}.3 3 Edit Pads Trig MIDI Message

2. Edit Pads Press MIDI Message

3.3.3 Edit Pads Mute MIDI Message
Edit Pads Solo MIDI Message

7.3.3 ]

5. Edit Pads Select MIDI Message

6. Choose Switch (and Pad) MIDI Message Type

7.3.3 (Choice between CC, Note, Start, Stop, Continue, Program Change,
Channel Pressure, Aftertouch and Off).

7.3.3 Choose Switch MIDI Message Number
(Not available for Start, Stop, Continue)

$.3.3 Choose Switch MIDI Message Channel
(Not available for Start, Stop, Continue)

3.3 3 Choose Switch MIDI Message Mode. Choice between Gate and Toggle.
(Not available for Start, Stop, Continue)

;03. 3 Choose Switch MIDI Message Minimum Value

e (Not available for Start, Stop, Continue)

11. Choose Switch MIDI Message Maximum Value

7.3.3 (Not available for Start, Stop, Continue)

12. Choose Switch MIDI Message Action On. Choice between Push or Release

(Not available in Gate Mode)
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7.3.4 Edit Instrument knob window

Track 1 Track 2 Track 3 Track 4 Track 5 Track 6 Track 7 @
Name TrckAux1 MIDI Channel 1

Message Type Control Change < " [oTs [ Relative3

Message Number 0 - Bank Select ... Acceleration Fast

1. Edit Instrument 1 to 8 Knob MIDI Message

2. Choose Knob MIDI Message Type
(Choice between CC and Off)

3. Choose Knob MIDI Message Number
(0 to 127)

4, Choose Knob MIDI Message Channel
(1 to 16)

5. Choose Knob MIDI Message Mode

(Choice between Absolute, Relativel, Relative2, Relative3)

6. Choose Knob MIDI Message Min Value
(0 to 127 (should be < max val))

7. Choose Knob MIDI Message Max Value
(0 to 127 (should be > min val))

8. Choose Knob MIDI Message Acceleration

(Choice between None, Slow and Fast - not available for encoder
with detent: Encoders with detent are Move, Jog Dial, Loop)

7.3.5 Edit Instrument parameter knob window

Knob
Name Trk1Knbl MIDI Channel 1

Message Type Control Change < Mode Relativel

Message Number 0 - Bank Select ... Acceleration Slow

1. Edit Instrument parameter knob 1 to 8 MIDI Message

2. Choose Knob MIDI Message Type
(Choice between CC and Off)

3. Choose Knob MIDI Message Number
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(0 to 127)

4, Choose Knob MIDI Message Channel
(1 to 16)

5. Choose Knob MIDI Message Mode

(Choice between Absolute, Relativel, Relative2, Relative3)

6. Choose Knob MIDI Message Min Value. 0 - 127

(should be < max value)

7. Choose Knob MIDI Message Max Value. 0 - 127

(should be > min value)

8. Choose Knob MIDI Message Acceleration

(Choice between None, Slow and Fast - not available for encoder
with detent: Encoders with detent are Move, Jog Dial, Loop)

7.3.6 Edit Clickable knob window
You will find only 2 clickable buttons on SPARK's Hardware:

7.3.6.1 The Jog Dial (Wheel)

1. Choose MIDI Message Type

(Choice between CC, Note, Start, Stop, Continue, Program Change,
Channel Pressure, Aftertouch and Off).

2. Choose Action on MIDI Message

(Choice between Push/release)

7.3.6.2 The Move button (Loop Move)

1. Choose MIDI Message Type

(Choice between CC, Note, Start, Stop, Continue, Program Change,
Channel Pressure, Aftertouch and Off).

2. Choose Switch MIDI Message Number
(0 to 127)

3. Choose Switch MIDI Message Channel
(1 to 16)

4, Choose Switch MIDI Message Mode.

(Choice between Toggle, Trigger, Gate, Inc, Gate and Toggle).
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5. Choose Knob MIDI Message Min Value. 0-127

(should be < max value)

6. Choose Knob MIDI Message Max Value. 0-127

(should be > min value)

7. Choose Switch MIDI Message Action On. Choice between Push or Release
(Not available in Gate Mode)

8. Choose Action on.

(Choice between Push/Release)

7.3.7 Edit Touch pad window

Filter X Filter Y Slicer X Slicer Y Roller X Roller Y
Name TouchPad MIDI Channel 1

Message Type Control Change Mode

Message Number 0 - Bank Select ... Acceleration

1. Choose Touch Pad MIDI Message Type
(Choice between CC and Off)

2. Choose Touch Pad MIDI Message Number
(0 to 127)

3. Choose Touch Pad MIDI Message Channel

4, Choose Touch Pad MIDI Message X or Y Minimum Value

0 to 127 (should be < maximum value)

5. Choose Touch Pad MIDI Message X or Y Maximum Value

0 to 127 (should be > minimum value)

7.4 CONTROLLING SPARK AN EXTERNAL MIDI CONTROLLER

7.4.1 Assign a MIDI note to pads

Click holding [Cmd] on Mac / [Ctrl]] on Windows on [Pads] #115 to #122 and press
button or key on your MIDI controller.

7.4.2 Assign a MIDI note to bank buttons

Same as previous on corresponding button/pad.

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’'S MANUAL 90



7.4.3 Assign a MIDI note to pattern buttons

Same as previous on corresponding button/pad.

7.4.4 Assign a MIDI note to loop on button

Same as previous on corresponding button/pad.

7.4.5 Assign a MIDI CC to Loop divide knob

Click holding [Cmd] on Mac / [Ctrl]] Win on [Loop] #49 and move knob or fader on your
MIDI controller.

7.4.6 Assign a MIDI CC to Loop Move knob

Same as previous on corresponding knob.

7.4.7 Assign a MIDI CC to shuffle knob

Same as previous on corresponding knob.

7.4.8 Assign a MIDI CC to master Volume knob

Same as previous on corresponding knob.

7.4.9 Assign a MIDI CC to cutoff/res/Pan/Aux1l/Aux2/Volume knobs

Same as previous on corresponding knob.

7.4.10Assign a MIDI CC to instrument parameters knobs

Same as previous on corresponding knob.

7.4.11Assign a MIDI CC to tempo knob

Same as previous on corresponding knob.
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8 SPARK CREATIVE DRUM MACHINE LEGAL
INFORMATION

8.1 SOFTWARE LICENSE AGREEMENT

In consideration of payment of the Licensee fee, which is a portion of the price you paid,
Arturia, as Licensor, grants to you (hereinafter termed “Licensee”) a nonexclusive right
to use this copy of the Spark Creative Drum Software (hereinafter the "SOFTWARE").

All intellectual property rights in the software belong to Arturia SA (hereinafter:
“Arturia”). Arturia permits you only to copy, download, install and use the software in
accordance with the terms and conditions of this Agreement.

The product contains product activation for protection against unlawful copying. The OEM
software can be used only following registration.

Internet access is required for the activation process. The terms and conditions for use
of the software by you, the end-user, appear below. By installing the software on your
computer you agree to these terms and conditions. Please read the following text
carefully in its entirety. If you do not approve these terms and conditions, you must not
install this software. In this event give the product back to where you have purchased it
(including all written material, the complete undamaged packing as well as the enclosed
hardware) immediately but at the latest within 30 days in return for a refund of the
purchase price.

1. Software Ownership

Arturia shall retain full and complete title to the SOFTWARE recorded on the enclosed
disks and all subsequent copies of the SOFTWARE, regardless of the media or form on or
in which the original disks or copies may exist. The License is not a sale of the original
SOFTWARE.

2. Grant of License

Arturia grants you a non-exclusive license for the use of the software according to the
terms and conditions of this Agreement. You may not lease, loan or sub-license the
software.

The use of the software within a network is illegal where there is the possibility of a
contemporaneous multiple use of the program.

You are entitled to prepare a backup copy of the software which will not be used for
purposes other than storage purposes.

You shall have no further right or interest to use the software other than the limited
rights as specified in this Agreement. Arturia reserves all rights not expressly granted.

3. Activation of the Software

Arturia may use a compulsory activation of the software and a compulsory registration of
the OEM software for license control to protect the software against unlawful copying. If
you do not accept the terms and conditions of this Agreement, the software will not
work.

In such a case the product including the software may only be returned within 30 days
following acquisition of the product. Upon return a claim according to § 11 shall not

apply.

ARTURIA - SPARK CREATIVE DRUM MACHINE - USER’S MANUAL 92



4. Support, Upgrades and Updates after Product Registration

You can only receive support, upgrades and updates following the personal product
registration. Support is provided only for the current version and for the previous version
during one year after publication of the new version. Arturia can modify and partly or
completely adjust the nature of the support (hotline, forum on the website etc.),
upgrades and updates at any time.

The product registration is possible during the activation process or at any time later
through the Internet. In such a process you are asked to agree to the storage and use of
your personal data (name, address, contact, email-address, and license data) for the
purposes specified above. Arturia may also forward these data to engaged third parties,
in particular distributors, for support purposes and for the verification of the upgrade or
update right.

5. No Unbundling

The software usually contains a variety of different files which in its configuration ensure
the complete functionality of the software. The software may be used as one product
only. It is not required that you use or install all components of the software. You must
not arrange components of the software in a new way and develop a modified version of
the software or a new product as a result. The configuration of the software may not be
modified for the purpose of distribution, assignment or resale.

6. Assignment of Rights

You may assign all your rights to use the software to another person subject to the
conditions that (a) you assign to this other person (i) this Agreement and (ii) the
software or hardware provided with the software, packed or preinstalled thereon,
including all copies, upgrades, updates, backup copies and previous versions, which
granted a right to an update or upgrade on this software, (b) you do not retain
upgrades, updates, backup copies und previous versions of this software and (c) the
recipient accepts the terms and conditions of this Agreement as well as other regulations
pursuant to which you acquired a valid software license.

A return of the product due to a failure to accept the terms and conditions of this
Agreement, e.g. the product activation, shall not be possible following the assignment of
rights.

7. Upgrades and Updates

You must have a valid license for the previous or more inferior version of the software in
order to be allowed to use an upgrade or update for the software. Upon transferring this
previous or more inferior version of the software to third parties the right to use the
upgrade or update of the software shall expire.

The acquisition of an upgrade or update does not in itself confer any right to use the
software.

The right of support for the previous or inferior version of the software expires upon the
installation of an upgrade or update.

8. Limited Warranty

Arturia warrants that the disks on which the software is furnished is free from defects in
materials and workmanship under normal use for a period of thirty (30) days from the
date of purchase. Your receipt shall be evidence of the date of purchase. Any implied
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warranties on the software are limited to thirty (30) days from the date of purchase.
Some states do not allow limitations on duration of an implied warranty, so the above
limitation may not apply to you. All programs and accompanying materials are provided
“as is” without warranty of any kind. The complete risk as to the quality and
performance of the programs is with you. Should the program prove defective, you
assume the entire cost of all necessary servicing, repair or correction.

9. Remedies

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a)
return of the purchase price or (b) replacement of the disk that does not meet the
Limited Warranty and which is returned to Arturia with a copy of your receipt. This
limited Warranty is void if failure of the software has resulted from accident, abuse,
modification, or misapplication. Any replacement software will be warranted for the
remainder of the original warranty period or thirty (30) days, whichever is longer.

10. No other Warranties

The above warranties are in lieu of all other warranties, expressed or implied, including
but not limited to, the implied warranties of merchantability and fitness for a particular
purpose. No oral or written information or advice given by Arturia, its dealers,
distributors, agents or employees shall create a warranty or in any way increase the
scope of this limited warranty.

11. No Liability for Consequential Damages

Neither Arturia nor anyone else involved in the creation, production, or delivery of this
product shall be liable for any direct, indirect, consequential, or incidental damages
arising out of the use of, or inability to use this product (including without limitation,
damages for loss of business profits, business interruption, loss of business information
and the like) even if Arturia was previously advised of the possibility of such damages.
Some states do not allow limitations on the length of an implied warranty or the
exclusion or limitation of incidental or consequential damages, so the above limitation or
exclusions may not apply to you. This warranty gives you specific legal rights, and you
may also have other rights which vary from state to state.

8.2 FCC INFORMATION (USA)

Important notice: DO NOT MODIFY THE UNIT!

This product, when installed as indicated in the instructions contained in this manual,
meets FCC requirement. Modifications not expressly approved by Arturia may void your
authority, granted by the FCC, to use the product.

IMPORTANT: When connecting this product to accessories and/or another product, use
only high quality shielded cables. Cable (s) supplied with this product MUST be used.
Follow all installation instructions. Failure to follow instructions could void your FFC
authorization to use this product in the USA.

NOTE: This product has been tested and found to comply with the limit for a Class B
Digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide
a reasonable protection against harmful interference in a residential environment. This
equipment generate, use and radiate radio frequency energy and, if not installed and
used according to the instructions found in the user’'s manual, may cause interferences
harmful to the operation to other electronic devices. Compliance with FCC regulations
does not guarantee that interferences will not occur in all the installations. If this product
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is found to be the source of interferences, which can be determined by turning the unit
“"OFF” and “ON”, please try to eliminate the problem by using one of the following
measures:

¢ Relocate either this product or the device that is affected by the
interference.

¢ Use power outlets that are on different branch (circuit breaker or fuse)
circuits or install AC line filter(s).

¢« In the case of radio or TV interferences, relocate/ reorient the antenna. If
the antenna lead-in is 300 ohm ribbon lead, change the lead-in to coaxial
cable.

e If these corrective measures do not bring any satisfied results, please the
local retailer authorized to distribute this type of product. If you cannot
locate the appropriate retailer, please contact Arturia.

The above statements apply ONLY to those products distributed in the USA.

8.3 CANADA

NOTICE: This class B digital apparatus meets all the of the Canadian Interference-
Causing Equipment Regulation.

AVIS: Cet appareil numérique de la classe B respecte toutes les exigences du Réglement
sur le matériel brouilleur du Canada.

8.4 EUROPE

C E This product complies with the requirements of European Directive89/336/EEC.

This product may not work correctly by the influence of electro-static discharge; if it
happens, simply restart the product.
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9 NOTES:
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